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Box contents: 

● A Future Impact v3 pedal; 
● A Quick-Start Guide. 

 

Items required but not included: 

● A 9V stabilized, 100mA, center-negative, Roland-Boss-type power supply. 
● A MIDI interface and two MIDI cables for use with a PC (Windows 7 and above) or 

MAC (OS X 10.6 (Snow Leopard) and above). (Minimum screen resolution - 
1280x900.) 
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EU Directives on the Protection of the Environment 
 
RoHS  This product is compliant with the EU Directive 2002/95/EG for the Restriction of 
the use of Certain Hazardous Substances in Electrical and Electronic Equipment. No lead 
(Pb) cadmium (Cd), mercury (Hg), hexavalent chromium (Cr + 6), PBB or PBDE is 
intentionally added to this device. Any traces of impurities of these substances contained 
in the parts are below the RoHS specified threshold levels. 
 
REACh This product is compliant with the European Union Directive EC1907/206 and 
contains none or less than 0.1% of the chemicals listed as hazardous chemicals in the 
REACh regulation. 
 
WEEE As with the disposal of all old electrical and electronic equipment, this product is 
not to be treated as regular household waste. Instead it should be handed over at the 
applicable collection point for the recycling of electrical and electronic equipment. 
 

This product complies with the European Union Council Directives and Standards 
relating to electromagnetic compatibility EMC Directive (2006/95/EC) and the Low Voltage 
Directive (2004/108/EC). EMC compliance test report: EMC – 130930/1 
 
Operation is subject to the following two conditions: 

1) This device may not cause harmful interference, and; 
2) This device must accept any interference received, including interference that may 

cause undesired operation. 

  

Panda-Audio Ltd. 

Széchenyi u. 8 

2040 Budaörs 

HUNGARY 

Tel.: +36-23-441-071 

Email: info@panda-audio.com 

  

Warranty 

If your Future Impact v3 breaks or malfunctions as a result of any defective electronic parts 
or due to a design fault of ours, we will repair or replace it during the warranty period, which 
is two years from the date of original purchase. 

WARNING: never operate the BANK button by foot. It must be operated by hand only. 
Damage to the BANK button will not be covered by the warranty. 
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Introduction 
Thank you for purchasing arguably the most revolutionary synthesizer effects pedal there is: 
the Future Impact v3. 
 
The Future Impact v3 harnesses all the power and versatility of some of the best (and 
best-loved) keyboard synthesizers and squeezes it into a small and portable stomp-box 
pedal format, making those wonderfully-inspiring and sometimes other-worldly sounds 
available to all instrumentalists. 
 
You now have in your hands the means to create and play classic synthesizer sounds like 
those heard on recordings by Herbie Hancock, George Duke, Stevie Wonder, Vince Clarke, 
Joe Zawinul, Chick Corea, Jan Hammer, Keith Emerson and countless others.  
 
The Future Impact v3 (FI) is an incredibly versatile pedal and the range of sounds it is 
capable of producing is quite staggering. In addition to producing synthesizer sounds such 
as basses, leads and pads, it can function as an octaver, chorus, flanger, phaser, distortion, 
envelope filter, traditional wah-wah, tremolo, reverb, etc. and even has a built-in tuner. As 
such, it can potentially replace a whole pedalboard of dedicated single-effect pedals. It has 
relay-switched true bypass so your input signal is unaffected when the pedal is off. 
 
The FI is monophonic, that is, it can only respond to input of one note at a time. It can be set 
up to produce 4-note chords and pad sounds but won’t respond to chordal input. It was 
originally designed for use with bass guitar, but in version 3 the pitch range has been 
extended so that it can now also be used with higher-pitched instruments such as guitar, 
clarinet, trumpet, etc. In several places in this manual the input instrument is referred to as 
“bass/guitar” as these are the most typically-used instruments, however, please remember 
that any pitched instrument that can be played monophonically can be used. Additionally the 
FI can be used as a monophonic synthesizer expander by connecting a keyboard, wind 
controller, computer or any other MIDI source to the MIDI input port. 
 
There are 99 onboard sounds but via the included Editor software, you have access to many 
more, either by downloading and transferring them to the pedal or by creating them yourself. 
 
In its original incarnation, the FI was already a powerfully expressive instrument. With the 
addition of the new features of version 3.00, its enhanced capabilities make it unparalleled in 
the field of synthesizer effects pedals. 

In the box, under your FI, you will find a Quick-Start Guide. It explains how to use the FI with 
a bass guitar and will allow you to dive right in to playing the pedal with the minimum of fuss. 
The information contained in the separate Quick-Start Guide also appears below in this 
manual, along with the Detailed Manual, which contains a complete description of how to 
use all the features of the pedal and the accompanying Editor software.  
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Main Features 
● 99 editable onboard sounds; many more available via the included Editor software; 
● Super-fast and accurate pitch tracking over the full range of 6-string bass or guitar;  
● 4 VCOs each with saw, square (with variable pulse width) and triangle waveforms; 
● 3 effects - Chorus, EQ and Overdrive; 
● Resonant filter with Lowpass, Highpass, Bandpass and Notch modes; 
● 12dB/oct and 24dB/oct filter slopes; 
● 2nd, parallel Bandpass filter; 
● Individual envelopes for VCA, VCF and Noise source; 
● Global LFO for VCOs and VCF; 
● Expression pedal control of LFO depth, filter cutoff and volume via MIDI; 
● Synth triggered either by an instrument’s audio signal or via MIDI; 
● A 3-voice harmonizer, 2 voices with variable transposition; 
● High-quality distortion for the harmonizer voices and dry input signal; 
● Built-in tuner; 
● Powered by a standard 9V, center-negative supply; 
● Low current draw of only 100mA; 
● Large 3-digit display - current sound’s location number is visible at all times; 
● All 99 sounds accessible directly from the pedal - no external equipment required; 
● Rugged and road-worthy metal housing; 
● Full-size MIDI IN and OUT ports; 
● Relay-switched true bypass. 

New features for version 3.00 
● Full ADSR envelopes, giving a hugely expanded sound palette; 
● Ability to use all 3 effects simultaneously and configure their order; 
● Improved tracking; 
● 10 new LFOs - including saw, square, triangle and sample-and-hold types; 
● Extended input and oscillator ranges - instruments of all pitches can now be used; 
● 4 Flexi Controllers - adds powerful real-time, user-controllable modulation capability 

which vastly increases expressive potential; 
● Envelopes and LFOs freely assignable via Flexi Controllers; 
● Extended pitch bend range of 24 semitones in either direction; 
● Portamento legato settings now completely independent of gate/trigger mode; 
● Detune Mode - chosen notes can be detuned by 50 cents, giving access to 

non-western scales; 
● Split Mode - only the synth signal is sent to the audio output so the input instrument 

signal can be split using a Y-cable or splitter box prior to the audio input socket; 
● Synth and EWI Mode - audio input signal can be decoupled from the synth triggering 

circuit to allow independent triggering by MIDI whilst still playing your bass/guitar; 
● Ability to back up programs directly from the pedal to a computer; 
● An exciting new factory default soundset created by experienced sound designers.  
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Quick-Start Guide 
The Future Impact v3 will let you play amazing and authentic synth lines from your bass, 
guitar or keyboard. You can choose from 99 onboard sounds that you can quickly shape to 
your taste. By using the pedal in conjunction with the included Editor software, you can 
branch out further and download many more free sounds created by experienced sound 
designers and other enthusiasts in the music community. You can also learn to build and 
share your own sounds, unlocking your creative potential and opening the door to 
inspirational music-making. 

This Quick-Start guide will show you how to set up and use the FI with your bass, including 
the use of the built-in tuner. The guide will also explain what the main sound-sculpting 
parameters are and how to adjust them easily on the pedal. 

If you want to delve deeper into the process of transferring new sounds to your pedal or 
creating your own then you will need to consult the Detailed Manual, though you may find 
some of the information you are looking for in the FAQ section at the very end of this 
manual. 

 

Setting up the Future Impact v3 

Connect your bass/guitar to the INPUT jack. Connect the OUTPUT to an amplifier. Use a 
Roland/Boss compatible 9V, minimum 100mA stabilized, center-negative power supply. You 
must use a power supply which matches the mains voltage and connector requirements of 
your country. A power supply is not included with the FI. 

Connect the FI to the proper supply to power it on. First, it will display the software version 
for one second, then it will display the instrument mode for one more second. It is very 
important to set the correct instrument mode for your instrument. (See the section below 
entitled Configuring the Future Impact v3 for details of how to set the instrument mode.) 
The default instrument mode is for bass guitar, displayed as “bSS”. 

See Editing the Configuration Parameters further below for a full explanation of the 
Instrument Modes. 

Press the ON/OFF footswitch (right) to turn the FI on. The ON LED will light up. Adjust the 
INPUT LEVEL dial so that the red LED lights up briefly only when your bass is played at its 
loudest. Adjust the OUTPUT LEVEL dial to your needs. 

Note: Due to the true bypass function of the FI, the level display will only work when the 
effect is ON. 
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Operating the Future Impact v3 

The FI has 99 sounds (programs) distributed across 10 banks: bank 0 has 9 sounds, all 
other banks have 10. You can step up through the banks by pressing the EDIT/BANK UP 
dial. Furthermore, if you press and hold this dial and turn it, you can quickly move up or 
down to any bank. 

Sounds are selected with the PROGRAM footswitch. A single press will move up by one 
program, a double press will move down by one. If you press and hold this footswitch, the 
number will scroll up, first slowly, then faster. If you hold this footswitch after a double press, 
the number will scroll down in the same manner. In this Program-Selection Mode, known as 
DIRECT Mode, moving up and down through the program numbers will seamlessly step over 
the bank borders so that you can access any of the 99 programs using just the one 
footswitch. 

Note: The FI is based on the detection of the bass/guitar’s pitch. To function correctly, it 
requires monophonic notes that are played cleanly. If you play chords, power chords, use 
slapping or tapping techniques, or try to use it outside of the pitch range of the selected 
instrument then unpredictable results will occur. 

  

  

Tuner 

The FI includes a very high-quality, fast-response tuner that uses the advanced pitch 
detection technology of the FI. To activate the tuner, press and hold the ON/OFF switch for 
one second. The tuner can be activated from both the ON and OFF states and in either case 
the audio output will be completely muted. In the display, the first digit shows the note name 
and the second digit shows (an approximation of) the # sign. The third digit shows the 
fine-tune value using one or more of the three horizontal lines as follows: 

Upper line only Sharp by > 10 cents 

Upper and middle lines Sharp by > 3 cents 

Middle line only In tune (within ±3 cents) 

Lower and middle lines Flat by > 3 cents 

Lower line only Flat by > 10 cents 

 

To exit tuner mode, press ON/OFF briefly and the FI will return to the ON state.  
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Note: While in tuner mode, the display will be blank if there is no input signal. 

The tuner is calibrated to the Tune Base value. This can be adjusted in the range of 
428Hz...440Hz...452Hz. See the Editing the Configuration Parameters section for 
instructions on how to set Tune Base. 

 

Editing the Sounds 

If you have found a sound that you want to modify for your music, the PARAMETER dial 
allows you to select and edit 11 different parameters. Two of these parameters are GLOBAL, 
thus common to all programs; the other 9 are editable on a per-program basis. All 
parameters have a default value of 5. You can deviate up to 4 steps away from the default 
setting (either downwards to 1 or upwards to 9) by turning the EDIT dial. Editing a parameter 
causes an immediate audible change to the sound and the decimal point starts blinking. 
Press the EDIT button to save the changes. Any unsaved changes will be lost when 
switching to a new program, pressing the ON/OFF footswitch or powering off the pedal.  

Note: Saving changes to a program using the EDIT button will cause that program to 
be the one that is loaded upon next powering on the FI. 

  

Description of the Parameters 

NOTE OFF LEVEL (global): Sets the volume threshold of the input signal below which the 
synth stops sounding. A lower value allows you to sustain notes longer. A higher value 
allows better articulation of staccato notes. 

NOTE ON LEVEL (global): Sets the volume threshold of the input signal above which the 
synth begins sounding. If low-volume notes do not trigger the synth then decrease the value. 
If multiple triggering occurs then increase the value. 

ATTACK: Sets the length of the attack stage of the filter AD/ADSR envelope. Higher values 
make the filter take longer to open after a note is played. 

DECAY: Sets the length of the decay stage of the filter AD/ADSR envelope. Higher values 
make the filter take longer to close again after it has opened. 

ENVELOPE DEPTH: Sets how much the filter opens in response to the filter AD/ADSR 
envelope. 

DYNAMICS: Sets how much the filter opens in response to playing dynamics. 

CUTOFF: Sets the cutoff frequency of the filter. Lower values yield a darker sound; higher 
values yield a brighter sound. 
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RESONANCE: Boosts the frequencies around the filter cutoff frequency. Lower values give 
a flat, wide peak; higher values give a narrow, sharp peak. 

BALANCE: Sets the balance between the bass/guitar sound and the synth sound. A setting 
of 9 mutes the dry bass/guitar sound entirely. 

LEVEL: Sets the overall output level of the sound. 

EFFECTS: Sets the amount of chorus, overdrive or tilt-EQ applied to the sound. For full 
details on how the effects are influenced by this parameter see the Effects Block section of 
this manual. 

  

Configuring the Future Impact v3 

This is done via a boot menu. Only the two most immediately important parameters of this 
menu are shown here; the complete list is shown in the Detailed Manual. 

The default configuration of the FI is for bass. 

To enter the boot menu, press and hold the PROGRAM (left) footswitch while powering on 
the pedal. Turn the PARAMETER dial to “Note Off Level” to see the name of a parameter 
and turn it clockwise to any other position to see that parameter’s value. The value is 
adjusted using the EDIT dial. Step through the parameters by pressing the left footswitch 
again. When editing is complete, turn the FI off and on again. 

The aforementioned two parameters of the boot menu are given below:  

● RESET ALL (“rS”) 
Value: 0, 1. (Default on reset is 0.) 
 
Change to 1 to reset all sound parameters to default (5) upon power-on. The default 
program loaded at power-on will be reset to 1. 
 

● INSTRUMENT MODE (“InS”) 
Value: bSS (Bass), SPL (Split), Gtr (Guitar), Snt (Synth), EUI (EWI). (Default on reset 
is bSS.) 
 
Choose the option for your instrument. If using an instrument not listed above then 
choose either Bass or Guitar, whichever one best fits the pitch range of your 
instrument. For a full explanation of each instrument mode, please see the Detailed 
Manual. 

  

End of Quick-Start Guide  

Go to Table of Contents 
12 



Detailed Manual 
The first section of this part of the manual will explain the complete list of configuration 
parameters located in the boot menu. The second section, which forms the bulk of the 
manual, will show you everything you need to know about the Editor. This begins by showing 
you how to download and install the software, connect the FI to your computer and update 
the pedal’s firmware. It then goes on to explain how to load, save, transfer and rearrange 
programs. The final part takes you through all of the controls and functions of the Editor in 
detail. 
 

Editing the Configuration Parameters 

As already mentioned, the Future Impact v3 has 99 onboard programs whose many 
parameters can be fully edited with the Editor software. As you may recall from the Editing 
the Sounds section of the Quick-Start manual, each program has a smaller subset of those 
parameters, which can be coarsely edited directly on the FI itself using the EDIT dial. In 
addition, there are the two Global Parameters, NOTE OFF LEVEL and NOTE ON LEVEL, 
which can likewise be edited with the EDIT dial.  

The FI also has 7 Configuration Parameters that are common for all Programs; these can be 
edited on the FI via a boot menu. Two of these parameters (Reset All and Instrument Mode) 
were already discussed in the Quick-Start Guide, but for the sake of completeness, they are 
repeated here in the complete list. 

To enter the boot menu, press and hold the PROGRAM (left) footswitch while powering on 
the pedal. Turn the PARAMETER dial to “Note Off Level” to see the name of a parameter 
and turn it clockwise to any other position to see that parameter’s value. The value is 
adjusted using the EDIT dial. Step through the parameters by pressing the left footswitch 
again. When editing is complete, turn the FI off and on again. 

The parameters of the boot menu are given below: 

● RESET ALL (“rS”) 
Value: 0, 1. (Default on reset is 0.) 
 
Change to 1 to reset all sound parameters to default (5) upon power-on. The default 
program loaded at power-on will be reset to 1. 
 

● DIRECT/LEGACY PROGRAM-SELECTION MODE (“PrG”) 
Value: 0 (DIRECT), 1 (LEGACY). (Default on reset is 0.) 
 
DIRECT Mode is the default setting for selecting a sound. Sounds can be selected 
with the PROGRAM footswitch. A single press will move up by one program, a 
double press will move down by one. If you press and hold this footswitch, the 
number will scroll up, first slowly, then faster. If you hold this footswitch after a double 
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press, the number will scroll down in the same manner. In this program mode, 
incrementing and decrementing the program number will seamlessly step over the 
bank borders so that you can access any of the 99 programs using just the one 
footswitch. 
 
LEGACY Mode is included in the FI for historical compatibility reasons. In this 
program mode, sounds are selected from within a bank by pressing the PROGRAM 
footswitch. Pressing it will move up by one program and the LEDs will start to blink 
but the sound will not change yet. Press the ON/OFF footswitch to activate the 
selected sound. A quick double-press of the PROGRAM switch will move down by 
one program. (Scrolling works the same as it does in DIRECT Mode.) 
 
We highly recommend using DIRECT mode as it is much more practical than 
LEGACY mode. 
 

● GLOBAL MIDI CHANNEL (“GLb”) 
Value: All, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16. (Default on reset is All.) 
 
“All” is global OMNI mode. 1…16 sets the global receive channel corresponding to 
the number chosen. If OMNI mode is selected then the MIDI output channel for 
Program Change that is sent out will be channel 1. 
  

● VCF CONTROL RANGE (“vCF”) 
Value: 1 (+/-1 octave), 2 (+/-2 octaves), 4 (+/-4 octaves). (Default on reset is 1.) 
 
Sets the Voltage Controlled Filter (VCF) control adjustment range used when the 
VCF frequency is controlled by MIDI CC11 or CC74, or when it is adjusted on the FI 
via the PARAMETER and EDIT dials. The center point of the range corresponds to 
the program’s preset cutoff value (as set by the VCF FRQ slider in the Editor). 
 

● TUNE BASE (“tBS”) 
Value: 428-452. (Default on reset is 440.) 
 
This is the tune base value for the synthesizer when it is used through MIDI IN as an 
expander. Using the FI with a bass guitar is not affected by this parameter, as the 
tuning of the synthesizer is locked to the tuning of the bass guitar in this case. When 
you move the parameter selector from its leftmost position, the display then shows 
the tune base value; this can be adjusted with the EDIT dial. The adjustment range is 
from 428 Hz (ca. -50 cents) to 452 Hz (ca. +50 cents). This adjustment will also set 
the base of the TUNER. 

Important: If you update your FI’s firmware to 3.00 from an older version then the 
tune base will not be at 440 and so the tuner will show “incorrect” pitch values. You 
must reset the tune base. You can do this by performing a RESET ALL. Alternatively, 
if you do not want to lose any program settings made with the PARAMETER and 
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EDIT dials, you can manually set the tune base to 440 (or any other desired value). 
 

● INSTRUMENT MODE (“InS”) 
Value: bSS (Bass), SPL (Split), Gtr (Guitar), Snt (Synth), EUI (EWI). (Default on reset 
is bSS.) 
 

○ Bass Mode: The pitch tracking is optimized and limited for the pitch range of 
the bass guitar. The entire range of a 24-fret, 6-string bass is covered. 
 

○ Split Mode: A variation of Bass mode, designed for using the FI on stage with 
two separate amplifiers (one for bass/guitar, one for synth), or for using in the 
studio where having separate bass/guitar and synth  channels may be 1

desired. In this mode you must split the signal prior to the FI’s input with a 
splitter box or a Y cable for the two destinations. 
 
Everything works as in Bass mode, but with the following differences: 

■ The direct audio signal portion of all programs is muted so that only 
the synth signal is sent to the FI’s audio output; 

■ The ON/OFF footswitch will not switch to true bypass when turned 
off, instead the output remains connected to the digital circuitry and 
all signals are muted. 
 

○ Guitar Mode: The pitch tracking is optimized and limited for the pitch 
range of the 6 string guitar. 
 

○ Synth Mode and EWI Mode: Most features of these two modes are the 
same. 
 
The audio input is separated from the pitch control and triggering so that an 
audio signal can be routed to the VCF and effects without affecting the synth 
sounds; 
 
Unlike in Bass/Split/Guitar modes, the FI will power on in the ON state; 
 
The Tuner feature has no use. Instead, a long press of the right-hand switch 
puts the FI into Detune Mode, which can be used to set up the FI to play in 
non-western tunings. 
 
Once Detune Mode is activated, the following will occur: 

■ Any previous detuning applied to notes of the chromatic scale will be 
reset; 

1 Strictly speaking in this case by “synth” we mean the contents of the VCF output, that is, any signal 
routed through the filter. 
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■ Any notes that are now played via MIDI will be set to transpose down 
by 50 cents upon exiting Detune Mode. 

Pressing the ON/OFF switch again will exit Detune Mode and the altered 
(detuned) scale can now be played. 
 
Note that the detuned scale will not be stored in flash memory, but must 
instead be initialized “on the fly” anytime you want to use it. This is not 
important for SYNTH (though it does not hurt) but it is useful for EWI. 
 
The difference between Synth and EWI Modes is only in the initialization of 
MIDI CC values. For completeness here are the initialization values in all 
Instrument Modes: 

 MIDI CC 

1 2 5 7 11 65 74 

 Bass/Split/Guitar 127 127 127 127 64 127 64 

Mode Synth 0 127 127 127 64 127 64 

 EWI 127 127 0 127 64 127 64 

 

Note: These MIDI CCs will be initialized to their default values on startup, on every 
program change and whenever the editor changes a Flexi source. 

 

● MIDI THRU (“trU”) 
Value: 0, 1 (Default on reset is 0.) 
 
If set to 0 then MIDI information presented to MIDI IN will not be passed to MIDI 
OUT. 
If set to 1 then all information presented to MIDI IN will be passed to MIDI OUT. 
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The Future Impact v3 Editor 

 
 
The FI v3 Editor is the place where all the magic happens. It can best be thought of as the 
control room of the pedal. If you want to move beyond the 99 onboard sounds and fully 
immerse yourself in the fascinating world of subtractive synthesis then this where to do that. 
 
The editor can be used to audition programs and edit them to your taste or to create your 
own sounds from scratch and save them to your computer. It can also be used to transfer 
programs between your computer and the FI. 
 
If you simply want to audition new sounds created by others and load them onto your pedal, 
or change the order of your pedal’s sounds, then read the section on the File Menu below 
and/or the FAQ section at the end. These are also the two places to look if you need to 
update the firmware in your FI. 
 
If you want to edit sounds or create your own then study the various blocks of the 
Parameters section. There is a lot of information there so you may need to keep referring 
back to it until you have a firm grasp. The sections are laid out clearly, logically and with 
examples where necessary, so this should hopefully help you to digest the information more 
easily. 
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The FI is a very complex device with over 100 fully-adjustable parameters per sound. These 
are mostly adjusted using sliders but there a few pushbuttons too. In order to get an 
overview we recommend you first familiarize yourself with the panel layout in the image 
above (or the one found here at the end of the manual) and investigate the block diagrams 
of the FI algorithms in the Appendix. On the first page of the Appendix, you will find a 
diagram of the whole device (minus the effects). Note however that the oscillators appear 
here just as a rough outline; the detailed diagram of the oscillators is on the second page. 
The third page shows how the effects block is inserted into the structure of the FI. 

The FI has two basic sound sources: The harmonizer/bass guitar block and the synthesizer 
block. The synthesizer is driven by the information derived from the bass/guitar sound. The 
bass/guitar must be played using clean, monophonic lines. The whole range of 24-fret, 6 
string bass and guitar is supported. Slapping, tapping or chordal playing does not provide 
accurate pitch information and can result in notes of unintended pitch being triggered on the 
synthesizer. The sounds of the FI can be created from the synthesizer sound, the 
harmonizer/bass guitar sound, or a mixture of the two. 

This all might seem quite daunting or confusing at first but don’t worry, the following sections 
of the manual will explain what all the controls do and teach you what you need to know in 
order to start editing sounds deeply or building your own. 
 
 

Installing the Editor 

Go to http://pandamidi.com/support and download the latest Distribution Package. The 
package contains the latest firmware file and editor software along with a folder containing 
the 99 factory default programs. Copy the editor software package into any directory on your 
computer, connect your MIDI interface to the computer and double-click FIEditor.exe (PC) 
or FIEditor.app (macOS). 

(For Mac users: The first time you launch the editor, macOS will inform you that you are 
about to launch an app downloaded from the internet. If you see a warning message saying 
that the app is not from the App Store and you cannot run it, it is because you have set your 
Mac to only allow apps from the App Store. If that is the case then in the Finder, Control-click 
the FIEditor.app, choose Open from the menu, and in the dialog that appears, click Open. 
Enter your admin name and password when prompted. The FIEditor.app will now be saved 
as an exception to your security settings and you can open it in the future by double-clicking 
it.) 

In the MIDI>Preferences pull-down menu at the top of the Editor screen, select the MIDI IN 
and MIDI OUT ports you want to use. The three options are listed and explained further 
below.  
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If you want to be able to write programs to the FI then 
you need two MIDI connections between the FI and 
your computer: 

1. MIDI OUT of the interface → MIDI IN of the FI; 
2. MIDI OUT of the FI → MIDI IN of the interface. 

If you just want to audition, edit and create sounds 
and save them to your computer (without writing them 
to the FI) then only connection 1 is needed. 

The MIDI IN and OUT ports are as follows: 

● Output Device selects which device the Editor uses to send MIDI information to the 
FI.  

● Input Device selects which device the Editor uses to receive MIDI information from 
the FI. 

● Keyboard Input Device is a second MIDI IN to the Editor. If you want to design a 
sound using a keyboard instead of the bass/guitar, connect the MIDI OUT of the 
keyboard to the computer via this second MIDI IN and the computer will perform a 
through function to the FI for the keyboard signals.  

Important: do not connect the FI’s MIDI OUT to the computer’s MIDI IN via Keyboard Input 
Device; the FI’s MIDI OUT should only ever be connected to the computer’s MIDI IN using 
FI Input Device. This is because from version 1.22 of the FI there is a MIDI through function 
implemented in the software. Since Keyboard Input Device also implements a MIDI 
through, connecting the FI MIDI OUT to the computer via this input would cause an infinite 
MIDI loop. 

 

The File Menu 

The options in the FILE pull-down menu are explained below. 
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● Select Directory: Specifies the location that the editor uses for loading and saving 
program files. 
 

● Load Program from File to Editor: Loads a program from your computer into the FI 
editor. 
 
The program file format of FI 3.0 is much more advanced than that of previous 
versions. The FI v3 editor can load program files that were created with an earlier 
editor, but will convert these to the new format when saving. 
 

● Save Program from Editor to File: Saves an edited program to your computer.  

You can save a program to your computer using any name up to 32 characters in 
length, but in order to write a program to the FI, the name must begin with a two-digit 
prefix between 01 and 99. This prefix determines the slot on the FI to which the 
program will be written. 

● Write Program from File to FI: Opens the selected directory and allows you to 
select one sound program and write it to the FI.  

Remember, the program must have a two-digit number at the beginning of its name. 
If it does not, first Load the program into the editor and then Save it with a two-digit 
prefix added to its name.  

Note: Whilst the Write Program from File to FI command appears to work even if 
you only have one cable connecting the computer to the FI, the editor will not receive 
confirmation of the writing action and an error message will appear; both cables must 
be used. 

● Write All Programs from Files to FI: Writes all programs from your selected 
directory to the FI in a single run.  
 
When you use this option you must have a bi-directional connection between the FI 
and the computer, otherwise an error will occur after writing the first program. 
 
If the directory contains two or more files that have the same two-digit prefix then the 
editor will generate an error message and the write process will not be possible until 
you have removed the duplicates. 

If the directory contains gaps, i.e. if 
any of the two-digit prefixes 
between 01 and 99 are not included 
in program file names, then the 
editor will present you with two 
options:  
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1. Gaps can be filled with the Default - the slots in the FI corresponding to the 
gaps will be overwritten with the lowest-numbered program in the directory; 

2. Gaps can be skipped - the slots in the FI corresponding to the gaps will be 
ignored and the original programs in those slots will be untouched. 
 

The above four load/save/write file menu items are 
also duplicated in the PROGRAM panel at the top 
left corner of the editor screen as LOAD, SAVE, 
WRITE ONE and WRITE ALL respectively. 

Instead of using LOAD each time you want to access a new program, you can simply 
use the - and + buttons (or the left and right arrow keys of your keyboard) to quickly 
step through the programs within your selected directory. You can also use the up 
and down arrow keys of your keyboard to change bank. 

(The INIT button is used to create an initialized program which serves as a useful 
starting point for a new sound. It is discussed further in the section on building your 
first sound.) 

 

● Save Program from FI to File: Allows you to save a single program from the FI to 
your computer. 
 
Note: Any modifications to a program’s parameters made on the pedal using the 
PARAMETER and EDIT dials will not be preserved when saving programs from the 
FI to files. The program will be sent with those parameters at their default setting (5). 

 

● Save All Programs from FI to Files: Allows you to save all 99 programs from the FI 
to your computer. 
 
Note: Unlike earlier versions, the programs in 3.0 format also store the first 32 
characters of the filename in the FI; when you go to save a program from your FI to 
your computer, the editor will suggest the original name of the file by default. 

Firmware Update 

● Firmware Update: Allows you to update the FI’s firmware to the latest version, which 
you should do whenever a new version is released. 
 
You can update the FI firmware directly in your web browser (Chrome only) by going 
to https://auraplug.com/fiupdate/start.html and following the on-screen instructions.  
 
Alternatively, you can download the latest firmware file from 
http://pandamidi.com/support and save it to your computer. Once you have done this, 
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follow the steps below to install the update: 
 

1. Connect a MIDI interface to the PC (see remarks about MIDI interfaces at the 
end of this description). Connect the FI bidirectionally to the interface, with 
two MIDI cables: 
 

○ MIDI interface MIDI OUT (assigned to Output Device) → FI MIDI IN; 
○ FI MIDI OUT → MIDI interface MIDI IN (assigned to FI Input Device). 

 
2. Power on the FI while keeping both footswitches pressed. The ON LED will 

start slowly blinking; all other LEDs and displays will be unlit; 
 

3. Click Firmware Update and select the update file. The filename has a format 
of FIxxx.ldr, where xxx is a three digit version number. 
 
The updater will first check if the FI is present. If it is not, then the update 
process will be ignored and the message “Future Impact not present” will 
appear. 
 
If the FI is present then the update will commence: the message “Loading 
Update...” will be displayed and the LED will blink more quickly.  
 
At the end of the process, which should take less than a minute, “Update 
successful!” will be shown and the LED will go back to blinking slowly.  
 
If there was a problem during the update the editor will display “Error!” and the 
update will be stopped - the LED might be on, off or blinking quickly.  

After a successful update, power the FI off and on again. Check that the version 
number which appears on the display is the same as the number of the update file. 
You can now start to use the FI. 

Important: If you update your FI’s firmware to 3.00 from an older version then the 
tune base will not be at 440 and so the tuner will show “incorrect” pitch values. You 
must reset the tune base. You can do this by performing a RESET ALL. Alternatively, 
if you do not want to lose any program settings made with the PARAMETER and 
EDIT dials, you can manually set the tune base to 440 (or any other desired value). 

If for some reason the update was unsuccessful (e.g. due to poor data transmission 
caused by faulty driver software of the MIDI interface) you will still be able to use the 
FI just as before with the old firmware. Even if power is interrupted during an update 
do not worry, the FI firmware update process is foolproof. Although the device may 
look dead in such a case, you can simply repeat the firmware update process again 
until it is successful. 

Whilst most MIDI interfaces are well implemented and can transfer large SysEx 
packages such as the FI firmware upgrade, some manufacturers do not test their 
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devices carefully enough to ensure they don’t suffer from data loss when sending 
large packages. While these poorly-tested MIDI interfaces can be used for all other 
functions of the FI Editor, they cannot be used for updating the firmware. Do not 
worry, even if an error occurs during the update process, it will not damage your FI in 
any way; after a failed update the FI will remain fully functional. 

 

● Convert All Programs from prg to pr3: Converts an entire folder of older format 
program files to the new v3 format. The new files will appear in the same folder. 
 
 

● Quit: Closes the FI editor. 

 

The Edit Menu 

Here there options to Undo or Redo any parameter changes made while editing a sound. 
The two functions can also be carried out by pressing CTRL+Z or CTRL+Y respectively. 

 

The View Menu 

The size of the Editor window can be chosen here. (The window can also be resized by 
left-clicking and dragging the bottom-right corner of the Editor screen.)  
 
The Editor Interface sub-menu offers three options:  

● Space is the classic skin; 
● Solid is the classic skin but without the space-themed background;  
● LCD is a photorealistic skin (new for v3.03). (A screenshot is shown in the appendix.) 

 
Note: Switching between the Classic and LCD skins requires the editor to be restarted. 

Go to Table of Contents 
23 



 

The Help Menu 

 
An embedded version of this User Guide can be accessed here. Clicking on Program 
Database will launch a web browser and take you to our dedicated sound-sharing website 
where you can download sounds from other users and upload your own. 

 

On-screen Keyboard 

In the lower middle part of the screen there is a 
keyboard. If you do not have your instrument handy 
then you can use this keyboard instead to trigger 
notes in order to test the sound. The keyboard is even 

“velocity sensitive” as it will produce different key velocity values depending on where you 
press the key; higher velocities are at the bottom, lower velocities at the top. 

Note: The on-screen keyboard only triggers the synthesizer portion of a sound. Therefore 
any program whose sound is partially (or entirely) constructed from your instrument’s audio 
signal will not play back as expected when using this keyboard. 

 

Parameters 
The bulk of the interface of the FI Editor consists of sliders and pushbuttons which control 
the various sound-shaping parameters within a program. These are organized into distinct 
logical groupings called blocks and are (with a few exceptions) labelled with a “watermark” 
text indicating the block’s name. Most blocks are subdivided into two or more sections and 
can be identified by the BOLD font above the panel. The individual sections of a block also 
have differently-colored panels. 

The various blocks are discussed below. The sliders and pushbuttons within each block are 
described (mostly) individually and their ranges or settings are given in parentheses after 
their names. 

Note: Double-clicking a slider will reset it to its lowest value. Pressing CTRL+Z or CTRL+Y 
will respectively undo or redo any edits made to parameters. 
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VCO Block 

 

The FI contains four identical Voltage Controlled Oscillators (VCOs) and these provide the 
basic sound source for the synthesizer. Each oscillator has three waveforms (saw, square 
and triangle) which can be used simultaneously. The sliders in this block adjust the tuning, 
volume and character of the oscillator. The oscillator blocks are located on the left-hand side 
of the editor screen and, moving from left to right, their sliders are as follows: 

● PITCH COARSE (-24...48): 
Determines the pitch of the oscillator in semitones. A setting of 0 will generate the 
same pitch as the input signal. 

● PITCH FINE (-63...63): 
Detunes the oscillator by fractions of a semitone. You can use this option to correct 
the imperfect harmonies of the well-tempered scale. 

● PITCH BEAT (-63…63): 
This is also a detuning control, but instead of detuning by a fraction of a semitone, it 
detunes by a fixed number of Hz. 
 
To illustrate this function let’s use the example of two oscillators pitched in unison, 
but slightly detuned in order to create a beating between them. The speed of this 
beating is known as the “beat frequency”. If you were to play a middle C and adjust 
the FINE slider to achieve a beat frequency of 2Hz, then playing the C an octave 
above would double the beat frequency to 4Hz; likewise, playing C an octave below 
would halve the beat frequency to 1Hz. If you instead detune using the BEAT slider, 
then the beat frequency will remain constant, irrespective of the pitch being played. 

● SAW VCA DECAY TIME (0...127): 
The amplitude of the saw waveform can be given its own individual decay envelope 
which will be triggered each time a new note is played. This parameter adjusts the 
decay time. 

● SAW VCA SAW DECAY (-63...63): 
This parameter determines the amplitude of the decaying portion of the saw 
waveform. A combination of SAW AMPLITUDE and SAW DECAY settings allows a 
wide range of possibilities. See the following four examples: 
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SAW 
AMPLITUDE 

SAW 
DECAY 

Behavior 

64 0 A steady waveform. 

0 63 A decaying waveform that fades to silence. 

32 63 A decaying waveform that becomes steady after the decay. 

64 -63 A waveform that fades in from silence. 

 

● PULSE WIDTH OFFSET (0…127): 
The pulse width of the square waveform can be adjusted between symmetrical (50% 
duty cycle) when set at 0 and narrow pulse (10% duty cycle) when set at 127. (See 
here for a diagram of the pulse width settings.) 

● PULSE WIDTH LFO FRQ (1...127): 
Each oscillator has its own dedicated LFO (low frequency oscillator) for modulating 
the pulse width of the square wave. Here you can adjust the LFO frequency. 

● PULSE WIDTH LFO DEPTH (0…127): 
This controls the amount of modulation from the aforementioned dedicated LFO. It is 
the programmer’s responsibility to make sure that the chosen combination of 
OFFSET and LFO DEPTH settings does not stray beyond the usable range of 
modulation. 

● AMPLITUDE SAW (0…127): 
Adjusts the volume of the sawtooth wave. This is a harmonically rich waveform, 
containing all the overtones of the harmonic series; the higher the frequency of the 
overtone, the lower its amplitude is. This gives a bright and buzzy sound. 

● AMPLITUDE SQR (0…127): 
Adjusts the volume of the square wave. This waveform contains only the 
odd-numbered overtones of the harmonic series. This gives a hollow sound. 

● AMPLITUDE TRI (0…127): 
Adjusts the volume of the triangle wave. This waveform also contains only the 
odd-numbered overtones of the harmonic series but, as their frequencies increase, 
their volumes taper off much more steeply than those in the square wave. This gives 
a deep sound with a strong fundamental. 

● AMPLITUDE VOLUME (0…127): 
This is the master volume of the oscillator. Along with the individual waveform 
amplitude sliders, this has an especially important role in the generation of foldover 
distortion (see below). 

● VCO TRANSPOSITION (-24...0…24): 
Located immediately to the right of VCO1 in the editor. Transposes all oscillators 
together in semitone steps. 
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There is a COPY option in the lower left part of the 
screen to copy all parameters of one oscillator to one 
or more of the other oscillators. Click on the VCO 
button to show the VCO checkboxes (if they aren’t 

showing already). Select a source VCO from the left side and the destination VCO(s) from 
the right side, then press COPY. 

 

Foldover Distortion 

A special feature of the FI is foldover distortion. Depending on the implemented algorithm, 
when a signal processor is overloaded it will either clip the peak of the signal or it will fold 
over. While clipping is often used to generate a moderate amount of overtones, foldover is 
practically never used since it generates such a high overtone content that the sound 
becomes unusable due to out-of-tune aliasing artifacts. However, the huge processing 
power of the FI allows the oscillators to be generated at an oversampling rate of 512 kHz, 
guaranteeing that the aliasing portion of the sound remains negligible.  

Foldover Distortion can happen in the FI either within a single oscillator or within a 
combination of multiple oscillators. 

Each individual waveform (saw, square or triangle) within an oscillator will drive the 
summation to maximum amplitude by itself if set to 127. Foldover Distortion can happen 
within this oscillator if the sum of all three of its waveforms’ amplitudes exceeds 127 
(depending on the phase of the components). 

Foldover distortion can also happen between separate oscillators when the sum of the 
amplitudes (i.e. VOLUME sliders) of all four of the FI’s oscillators exceeds 127. In clean 
default sounds the oscillator master volumes are set to 32, thus avoiding foldover. The effect 
of foldover distortion between oscillators that are tuned to different frequencies (either 
coarsely or finely) is rather unpredictable so leaves a lot of room for experimentation. 

Since each oscillator can be made to have two dynamically changing portions (PULSE 
WIDTH and SAW VCA), these can be used to create sounds with dynamically changing 
spectra, even without using a filter. 
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Distortion Block 

 

The Distortion block applies distortion to the original instrument signal and to the three 
transposed voices generated by the Harmonizer.  VOICE1 is fixed at 1 octave above the 2

input signal, whereas the transpositions of VOICE2 and VOICE3 are variable. 

The Distortion block is also the source of the Attack/Release Distortion. See the detailed 
explanation of Attack/Release Distortion in the VCF INPUT section of the VCF Block. 

Moving from left to right, the sliders of the Distortion block are as follows:  

● HARMONIZER TRANSPOSE VOICE2/VOICE3 (-12, -5, 7, 12, 19, 24): 
Sets the transposition in semitones of the two variable voices. Identical settings of the 
two voices are scaled such that they are not exactly equal and will have a slight 
beating between them. 

● HARM MIXER INSTR/VOICE1/VOICE2/VOICE3 (0...127): 
Sets the volume levels of the input instrument signal and the three transposed voices 
of the Harmonizer being sent to the distortion. 

● DISTORTION GRADE (0…31): 
Adjusts the degree of distortion. Even at 0, some distortion is still present. 

● DISTORTION TONE (0…127): 
Sets the tone of the distortion. The filter is an equalizer set to 2100 Hz and Q=0.8. 
The slider cuts or boosts by up to 11dB at this frequency. A setting of 64 is flat (0dB). 

Note: When the FI is played solely via its MIDI IN port, the Distortion block has no function. 
This is because it is only driven by the audio input signal of your instrument connected at the 
INPUT socket. 

 

2 The Distortion block does not apply distortion to the synth signal. The distorted sound does 
however get routed through the filter so can be shaped to create synth-like sounds.  
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Envelopes Block 

 

Envelopes are configurable control signals which are used to adjust parameters over time. 
The two most common uses of envelopes in synthesizers are to adjust the loudness of the 
oscillators and to adjust the filter cutoff frequency. An envelope is made up of distinct 
portions called “stages”. The most widely used four stages are ATTACK, DECAY, SUSTAIN 
and RELEASE (ADSR). (The FI’s envelopes have either two or four of these stages, 
depending on the mode selected.) The A, D and R stages are time-based parameters 
whereas the S stage is a level (or amount) parameter. The stages are described below: 

● ATTACK sets the time the envelope takes to rise from zero to maximum after a note 
is played. 

● DECAY sets the time the envelope takes to decay from maximum back down to the 
level set by the SUSTAIN. 

● SUSTAIN sets the level the envelope maintains after the decay stage has finished. 
● RELEASE sets the time the envelope takes to decay from its current level back down 

to zero when a note is released. 

The FI has three dedicated envelopes which control the Voltage Controlled Amplifier (VCA), 
the Voltage Controlled Filter (VCF) and the Noise Generator respectively. The VCA and VCF 
envelope generators have three different modes (VINTAGE, ADSR in RESTART and ADSR 
in RESET-TO-ZERO) which are selected using the Envelope Mode slider. 

Moving from left to right, the sliders of the Envelopes block are as follows: 

● ENV MODE (VINTAGE/RESTART/RESET): 
Sets the behavior of both the VCA and VCF envelopes as described below. 

● VCA A/(D)/(S*)/R (1...127): 
Changes the volume of the synth signal coming from the VCOs dynamically over 
time. 

● VCF A/D/(S*)/(R) (1...127): 
Changes the cutoff frequency of the filter dynamically over time. 

● NOISE A/D (1...127): 
Changes the volume of the noise source dynamically over time. 

* The sustain stages of the two ADSR envelopes actually start their range from 0. 
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Note: The VCF and NOISE envelopes can be freely assigned to many other parameters 
when used as a control source with a Flexi Controller. (See the section on Flexi Controllers 
below for a detailed explanation.) 

 

Envelope mode behavior  

There are 3 different envelope behavior modes. 

In VINTAGE mode the envelopes are the same as those found in earlier versions of the FI 
software. (Here the D and S sliders of the VCA envelope and the S and R sliders of the VCF 
envelopes are greyed out and cannot be used.) In this mode, all three envelopes have a 
linear ramp and are triggered each time you play a note. They differ as follows: 

The VCA envelope is Attack-Release (AR). This means that when you play a note, the VCA 
envelope’s attack stage will start from zero and rise to maximum. It will maintain this level 
until you release the note, whereupon it will enter the release stage and fade out with a 
release time.* 

The VCF envelope and the NOISE envelope are both Attack-Decay (AD). This means that 
when you play a note, they will start from zero and rise to maximum, whereupon they 
immediately begin to decay to zero. 

Note: While the synthesizer sound is gated with the VCA envelope, the noise source is not; 
therefore, if you play short notes and the DECAY stage of the NOISE envelope is set long, 
the noise can be sustained longer than the synthesizer note itself. 

* The VCA envelope behaves in the manner described above only when it is triggered via 
MIDI; when it is triggered by your instrument, then the sound decays either with the release 
time of the VCA envelope as set by its slider or with the natural release of the instrument’s 
sound as the note is stopped, whichever is shorter. This allows for much more natural 
sounds from instruments such as the bass guitar. 

 

In RESTART and RESET modes, all sliders of the VCA envelope and of the VCF envelope 
become active giving full ADSR envelopes, practically identical to those found in a classic 
1970s 3-oscillator monosynth. They can be adjusted in a range of 1 millisecond to 10 
seconds. Unlike the AD and AR envelopes in vintage mode, the two ADSR envelopes have 
an exponential ramp and their adjustment range is extended strongly in both directions. 

The RESTART and RESET modes differ only in how they behave when a new trigger event 
occurs before the envelope generator has completed its previous envelope sequence: 

In RESTART mode the envelope will begin a new attack stage from whatever level it was at 
immediately before the note was played; 
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In RESET (or RESET-TO-ZERO) mode the envelope will always start the new attack stage 
from zero. So every note will have an identical attack.  

It is important to note that the release stage of the ADSR generators can only be fully 
exploited when the FI is played via MIDI. Since the pitch of a bass/guitar signal gets out of 
tune at the moment the amplitude fall triggers the note-off phase, this effect must be 
suppressed to avoid out-of-tune notes. This is done by ensuring that the actual release is the 
shorter of either the bass/guitar’s own release or the ADSR release setting. 

 

 

VCF Block  

 

The Voltage Controlled Filter (VCF) is one of the most important sound-shaping tools in a 
synthesizer. Basically it removes certain frequencies from a sound, thus altering its harmonic 
content. Depending on the type of filter used, the frequencies above, below or at a specified 
“cutoff” frequency are removed. This cutoff frequency can be modulated dynamically from 
different sources (e.g. an envelope), thus creating sounds which evolve over time. 

The FI has two filters which are connected in parallel. The first can be switched between 
Lowpass, Highpass, Bandpass and Notch types. The second is Bandpass-only and its cutoff 
can be offset from that of the first. The filters have both 12dB and 24dB per octave slopes 
and two scaling modes. 

The VCF Block is split into two sections in the editor: 

1. VCF INPUT - A five-channel audio mixer which feeds into the filter. 
2. FILTER - As described above. 

VCF INPUT 

Moving from left to right, the sliders in this section are as follows: 

● VCF INPUT INSTR (0...127): 
Sets the volume of the direct audio signal of your instrument. Unity gain is at 127. 
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● VCF INPUT DIST (0...127): 
Sets the volume of the signal coming from the Distortion block. 

● VCF INPUT AR DIST (0...127): 
Sets the volume of the signal coming from the Distortion block but processed in a 
special way. (See Attack/Release Distortion below for details.) 

● VCF INPUT SYNTH (0...127): 
Sets the volume of the audio signal coming from the VCO block (the synthesizer).  

● VCF INPUT NOISE (0...127): 
Sets the volume of the audio signal coming from the noise generator. 

 

Attack/Release Distortion 

As mentioned earlier, the synthesizer signal passes through the VCA and its loudness 
contour is controlled by the VCA envelope. If you set a long attack time on the VCA 
envelope, then the synth sound will fade in slowly after a note is played. By contrast, the 
loudness contour of the distortion signal is ordinarily only controlled by the volume envelope 
of your instrument. Like the DIST slider, the AR DIST slider also controls the volume of the 
sound coming from the Distortion block. The key difference is that the signal sent to the AR 
DIST slider gets first further processed through its own separate VCA; this separate VCA is 
controlled by the inverted version of the (synthesizer) VCA envelope set in the Envelopes 
block.  

The practical use of this feature comes when using AR DIST and SYNTH together and can 
be illustrated by the following example. Set the AR DIST and SYNTH sliders so that the 
volumes of their audio signals are roughly the same and set a relatively long attack time on 
the VCA envelope. Now when you play a note, you will initially only hear sound from the 
Distortion block but this then crossfades into sound from the VCO block (Synthesizer). 
Although relatively few of the factory sounds use this feature, this can be used to perfectly 
mask any potential tracking errors or latency of the synthesizer sound. 

Beware that even when in the (exponential) ADSR envelope modes, the AR DIST is still 
controlled by a linear AR envelope. This means that the crossfading will not happen as 
smoothly as it does in Vintage mode. 

Note: When the FI is played solely via its MIDI IN port, adjusting the INSTR, DIST and AR 
DIST sliders will have no effect. This is because they control audio signals derived from the 
input signal of your instrument connected at the INPUT socket. 
 

FILTER 

The rightmost four sliders in the filter section adjust the depth of control signals which 
modulate the filter’s cutoff frequency. The remaining sliders and buttons adjust the filter’s 
character and behavior. 
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Moving from left to right, the sliders (or pushbutton switches, where indicated) in this section 
are as follows: 

● VCF FILTER MODE PUSHBUTTON (VINTAGE/NEW): 
Toggles between two slightly different control curves for the VCF. Whereas the Deep 
Impact had an inaccurate approximation of the necessary exponential filter control 
characteristic, the Future Impact has a perfect implementation. However, in order to 
faithfully reproduce the Deep Impact sounds it was necessary to emulate the 
imperfection of its filter. Therefore, in the Deep Impact emulation sounds (programs 
21-29 of the default set) the VCF switch is set to VINTAGE. Since the accessible 
frequency range in the two modes is not the same, the frequency slider will be reset 
to the minimum whenever you toggle between modes. 
 

● VCF FILTER SLOPE PUSHBUTTON (12 dB / 24 dB): Toggles the filter mode 
between 12 dB/octave and 24 dB/octave. This adjusts how drastically the 
frequencies around the filter’s cutoff point are attenuated. 24 dB is the more drastic. 
 

● VCF FRQ (0...80 (VINTAGE), 36...122 (NEW)): 
Adjusts the cutoff frequency of the filter. Depending on the filter type selected (see 
VCF TYPE below), the frequencies above, below or at this point will be attenuated. 
 

○ In VINTAGE mode the scaling of this parameter is roughly 10 units per 
octave. 

○ In NEW mode, the slider’s value actually displays MIDI note numbers. The 
filter’s cutoff frequency is therefore that of whichever MIDI note is currently 
shown. (MIDI note 36 is 65.41 Hz; MIDI note 122 is 9397.27 Hz.) 

The cutoff of the filter can be controlled in real time using either MIDI CC11 or CC74. 
It can be made to deviate ±1, ±2 or ±4 octaves from the cutoff value set by the VCF 
FRQ slider in the program. The range is set by VCF CONTROL RANGE in the boot 
menu. 
 

● BPF FRQ (OFF, 1...24): Sets the cutoff frequency of the parallel second 
(bandpass-only) filter, measured as an offset in semitones from the cutoff frequency 
of the first filter. OFF bypasses the second filter. 
 
Both filters share the resonance parameter and cutoff control signals and respond 
equally to them. 
 
Offsetting the cutoffs of the two filters creates dual resonant peaks and provides an 
excellent way to generate sounds with vowel-like formants resembling the human 
voice. 
 

● RESO (7…127): 
Adjusts the resonance peak (or “Q”) of the filter on a scale of Q=0.7...12.7. Higher 
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values boost the frequencies at the filter’s cutoff point creating a characteristic peak. 
 

● VCF TYPE (LPF, HPF, BPF, NTC, OFF): 
Selects between Lowpass, Highpass, Bandpass and Notch filter types. Setting the 
slider to OFF will only bypass this filter; the second (Bandpass-only) filter will remain 
active unless the BPF FRQ slider is also set to OFF. 
 
The four filter types are as follows: 

1. Lowpass - Attenuates the frequencies above the cutoff; 
2. Highpass - Attenuates the frequencies below the cutoff; 
3. Bandpass - Attenuates the frequencies on either side of the cutoff; 
4. Notch - Attenuates the frequencies at the cutoff. 

 
● ENV FOLLOW (0...127): 

Adjusts the extent to which the filter’s cutoff is modulated by the Envelope Follower. 
The envelope follower signal corresponds exactly to the volume envelope of the input 
instrument. 
 

● AD/ADSR (0...127): 
Adjusts the extent to which the filter’s cutoff is modulated by the fully-adjustable VCF 
AD/ADSR Envelope set in the Envelopes block. 
 

● ACCENT (0...127): 
Adjusts the extent to which the filter’s cutoff is modulated by the initial volume of the 
input instrument at the moment a note is played. 
 
Like the Envelope Follower, Accent is a dynamics parameter. Whereas the Envelope 
Follower outputs a continuously-changing signal which exactly follows the amplitude 
curve of the input instrument, accent outputs a steady signal determined by the 
instrument’s initial loudness value. 
 
When the FI is played using its MIDI IN port, Accent adjusts the extent to which the 
filter’s cutoff is modulated by keyboard velocity. 
 
Note: In earlier versions of the FI firmware it was the Envelope Follower which 
adjusted the extent to which the filter’s cutoff was modulated by keyboard velocity. So 
if a program which uses the MIDI input is ported to the new 3.00 format, then the 
Envelope Follower parameter value must be copied to the Accent parameter in order 
for the program to play as expected. 
 

● PITCH FOLLOW (ON/OFF): 
If switched to ON then the filter cutoff will be modulated by the pitch of the note being 
played. The filter cutoff tracks the input pitch 1:1. That is, playing a note one octave 
higher will double the cutoff frequency; playing one octave lower will halve the cutoff 
frequency. 
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This can be used for many purposes. One example is to generate tuned whistling 
sounds by setting filter resonance high. 

  

LFO Block 

The FI has a dedicated Low Frequency Oscillator (LFO) for modulating the cutoff frequency 
of the VCF and the pitch of the VCOs. This can be used to create pitch vibrato and filter 
“wobbles”. 

Moving from left to right, the sliders of the LFO block are as follows: 

● LFO FRQ (1...127): 
Sets the frequency of the LFO. 

● LFO DELAY (0…127): 
Each time a new note is played an envelope is started that fades in the LFO 
amplitude with a variable delay. If set to zero then the set LFO amplitude is reached 
immediately. 

● LFO VCF / VCO (0…127): 
Sets the LFO depth individually for both destinations. 
 
If desired, the modulation depths of both LFO VCF and VCO can be controlled 
together by MIDI CC1. The depth set in the program by the two sliders will be 
reached if CC1 is at maximum (127). (See Remark 1 in the MIDI Implementation 
section for more details.) 

Note: The LFO can be freely assigned to many other parameters when used as a control 
source with a Flexi Controller. (See the section on Flexi Controllers for a detailed 
explanation.) 
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MIDI Block 

The parameters in this block are relevant only if the FI is played using its MIDI IN port. The 
FI actually has two separate internal modes for when it is used with an instrument via the 
audio input or when it is used via MIDI IN; switching between these modes happens 
automatically. Whenever a proper audio input signal is detected, the FI switches to 
Bass/Guitar Mode (except in SYNTH and EWI modes, in which audio is decoupled from 
pitch tracking/triggering). Similarly, whenever a MIDI NOTE ON is detected, the FI switches 
to MIDI Mode.  

In Bass/Guitar Mode the filter cutoff can be controlled by both the Envelope Follower and the 
Accent parameters. By contrast, in MIDI Mode, only the Accent parameter has a function 
and that is to adjust the effect of key velocity on the VCF cutoff. Please note that this causes 
a slight compatibility issue because in earlier versions of the FI software it was the Envelope 
Follower which adjusted the effect of key velocity on the VCF cutoff. So if a program which 
uses the MIDI input is ported to the new 3.00 format, then the Envelope Follower parameter 
value must be copied to the Accent parameter in order to play as expected. 

Moving from left to right, the sliders (or pushbutton switches, where indicated) of the MIDI 
block are as follows: 

● PORTA TIME (0...127): 
Sets the portamento time. If this is set to a non-zero value, the pitch will glide from 
one note to the other with an adjustable time. 

● PORTAMENTO SLOPE PUSHBUTTON (TIME, RATE): 
FIXED TIME means that the portamento time between any two notes will always be 
the same, no matter how far apart they are. FIXED RATE means that the portamento 
rate will always be the same, so the greater the distance between the two notes, the 
longer portamento time will be. 

● PORTAMENTO MODE PUSHBUTTON (ALWAYS, LEGATO): 
This switch determines whether portamento will happen on every new note or only on 
notes that are played legato. 

● KEYBOARD MODE PUSHBUTTON (TRIG, GATE): 
In GATE MODE a new attack stage of the envelopes will only occur if you release all 
keys before pressing another. In TRIGGER MODE a new attack stage will occur 
upon every keypress. 

● KBD PRIORITY (LOWER, UPPER, FIRST, LAST): 
Keyboard priority. This parameter determines what happens if you play more than 
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one note at a time. LOWER: Whichever note is lowest will be played. UPPER: 
Whichever note is highest will be played. FIRST: Whichever note was pressed first 
will be played. LAST: Whichever note was pressed last will be played. 

● PBD RANGE (0…24): 
Sets the pitch bend range (both up and down) in semitones when the pitch bend 
wheel is used. 

Note: Portamento can be switched on and off using MIDI CC65. The portamento time can 
be adjusted with MIDI CC5; the portamento time set in the program by its slider will be 
reached if CC5 is at maximum (127). (See the section on MIDI Implementation for details.) 

 

Main Mixer Block 

This is a simple two-channel audio mixer situated before the final output to the effect section.  

Moving from left to right, the sliders in this block are as follows: 

● INSTR (0...127): 
Sets the volume of the clean input instrument signal. Unity gain is at 127. 

● VCF LIN (0...127): 
Sets the volume of the signal coming from the output of the entire VCF block using a 
linear scale. (This signal comprises all five sliders of the VCF INPUT section, routed 
through the filter section).  

● VCF LOG (0...127): 
This slider adjusts the same signal as the VCF LIN slider but instead uses a 
logarithmic scale. This gives a more natural sweep of the input values and so offers a 
useful alternative for controlling the VCF volume path when working with Flexi 
Controllers. (Flexi Controllers are explained in a dedicated section below.) 

Note: In order to hear the sound coming from the VCF, both the VCF LIN and the VCF LOG 
sliders must be set to non-zero values. 

There is also a third VCF volume control not found on the editor panel that is adjusted via 
MIDI CC 2. This third volume control also uses a logarithmic scale. The three volume 
controls are in series. The adjustment is smoothed and slew-rate limited for each of them to 
4 msec at maximum deviation from zero to maximum or the other way round in order to 
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avoid clicks (especially on sudden large changes of MIDI value). (See Remark 2 in the MIDI 
Implementation section for more details.) 

 

Effects Block 

 

This block contains three effects: Overdrive, EQ and Chorus. They can be used 
simultaneously. Chorus is fixed at the end of the chain but the order of the other two can be 
changed at will. The effects are fed by the INSTR and VCF outputs from the Main Mixer. 

The panel for only one of the three effects can be displayed at any one time. Click on one of 
the three tabs (OVERDRIVE, EQUALIZER, CHORUS) above the panel to display that 
effect’s panel - that tab will now become light gray. 

There are three sliders common to each of the effects. Moving from left to right they are as 
follows: 

● ON/OFF (ON/OFF): 
Activates or bypasses the effect. When activated, the effect’s tab will be illuminated 
with a red border. 

● INSTR (ON/OFF (EQ and Overdrive), 0...127 (Chorus)): 
A blend control regulating how much of the dry input instrument signal from the Main 
Mixer gets sent to the effect.  

● VCF (ON/OFF (EQ and Overdrive), 0...127 (Chorus)): 
A blend control regulating how much of the VCF signal from the Main Mixer gets sent 
to the effect. 

 

To the right of the three effects tabs there is a small icon which shows the effects chain 
order. Clicking on this icon toggles between the two following options: 

1.  

2.  
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If any of the effects is turned off then its tab’s border will become dim. This way you can 
roughly adjust each effect individually, turn on the required combination to check the sound 
and then make any fine adjustments. The three effects will be explained in turn below. 

Effect 1: Overdrive 

 

Moving from left to right, the sliders of this effect are as follows: 

● DRIVE (0...127): 
Sets the amount of distortion. 

● LEVEL (-6…+6): 
Adjusts the output level in 1dB steps. Adjusting DRIVE will change the level of the 
signal in a somewhat unpredictable manner, therefore an output level adjustment is 
necessary here. 

  

Effect 2: Equalizer 

 

The Equalizer consists of a bass shelf tone control, two parametric band equalizer stages, 
and a treble shelf tone control.  

Moving from left to right, the sliders of this effect are as follows: 

● BASS FRQ (0...127): 
Adjusts the frequency of the bass shelf filter in the range of 50...270 Hz. 

Go to Table of Contents 
39 



● BASS SLOPE (0...127): 
Adjusts the steepness of the bass filter in a range of 3...10dB/octave. 

● BASS BOOST (-20…+20): 
Boosts or cuts the bass by up to 20dB. 

● MID1 FRQ, MID2 FRQ (0…127): 
Adjusts the center frequency of the equalizer stages in the range of 170...7000Hz. 

● MID1 Q, MID2 Q (10...100): 
Adjusts the resonance (Q) of the equalizer stages in a range of 1...10. 

● MID1 BOOST, MID2 BOOST (-20...+20): 
Boosts or cuts the equalizers by up to 20dB. 

● TREBLE FRQ (0...127): 
Adjusts the frequency of the treble shelf filter in the range of 2000...7000 Hz. 

● TREBLE SLOPE (0...127): 
Adjusts the steepness of the treble filter in the range of 3...10dB/octave. 

● TREBLE BOOST (-15...+15): 
Boosts or cuts the treble up to 15dB. 

The Equalizer section has an optional graphical editor too (see the screenshot at the 
beginning of the Effects Block). Above the Equalizer panel there are two small icons: 

The left one selects the panel with sliders (described above); the right one 
selects the panel with the graphical editor.  

Using the mouse with the graphical editor you can adjust the frequency of a filter stage by 
clicking and dragging the yellow dot left and right. You can similarly adjust the boost/cut by 
clicking and dragging up and down. Using the right mouse button to click and drag (either 
left-right or up-down), you can adjust the steepness of the low and high shelving filters in 
dB/octave and the Q value of the mid filters. 

Note: You can only assign an EQ parameter as a destination for a Flexi Controller from 
within the slider-based panel. As soon as an EQ parameter has been assigned as a Flexi 
destination, the graphical EQ panel will be disabled for as long as the assignment remains in 
place. (See the section on Flexi Controllers below for a detailed explanation of their 
function.) 

 

Effect 3: Chorus 
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This effect is very flexible; in addition to Chorus, it can be configured as a Flanger, Slapback 
Echo or simple Reverb merely by setting the parameters differently. It consists of two delay 
lines and two LFOs. Both LFOs can modulate both delay lines simultaneously by arbitrary 
amounts using four fully-independent modulation depth controls.  

Since there are two delay lines and two LFOs, there are two identical sets of sliders. For 
simplicity they are paired together in the description below. 

Moving from left to right, the sliders of this effect are as follows: 

● LFO A FRQ, LFO B FRQ (0...127): 
Adjusts the frequency of the two LFOs. 

● LEVEL1, LEVEL2 (-64...63): 
Adjusts the output level of the two delay lines. The amplitude can be negative, which 
is important for flanger sounds if the delay value is very small, or if the two delay 
values are very close to each other. 

● DELAY1, DELAY2 (0...127): 
The delay time can be adjusted here. The maximum value is approximately 160ms. It 
is the sound designer’s responsibility to ensure that the combination of delay and 
modulation settings remains within a usable range. 

● MOD1A, MOD1B, MOD2A, MOD2B (0...127): 
Adjusts the amount of modulation from LFOs A and B that is applied to the delay 
lines 1 and 2. 

● FBCK LEVEL (0...127): 
Adjusts the feedback level. It is the sound designer’s responsibility to set the 
feedback level moderately so that no oscillation occurs. Oscillation can choke off the 
sound completely; if this happens, simply lower the feedback slider again. 

● FBCK DMP (0..127): 
Adjusts the feedback damping. This is a lowpass filter applied to the feedback path. It 
can emulate the natural damping of walls in a room. 

Note: LFO A and LFO B can be freely assigned to many other parameters when used as a 
control source with a Flexi Controller. (See the section on Flexi Controllers for a detailed 
explanation.) 

 

Adjusting effects on the FI with the PARAMETER and EDIT dials 

Setting the data digit on the FI to default (5) using the EDIT dial will reproduce the effects 
settings exactly as they were saved in the editor. 

The EDIT dial will only adjust the last active effect in the chain.  

When OVERDRIVE is last in the chain, turning the EDIT dial towards 9 will increase DRIVE; 
turning towards 1 will decrease it. 
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When CHORUS is last in the chain, turning the EDIT dial towards 9 will increase both the 
INSTR and VCF blends; turning towards 1 will decrease them. 

When EQ is last in the chain, the EDIT dial functions as a “tilt EQ”. Turning the EDIT dial 
towards 9 will simultaneously boost the treble and cut the bass in 2dB steps (leaving the mid 
controls unchanged); turning towards 1 will simultaneously cut the treble and boost the bass 
in 2dB steps. So effectively, turning the EDIT dial to a higher value will make the sound 
sharper, whereas turning it to a lower value will dampen the sound. 

  

Flexi Controllers 

 

The most important and exciting new feature in the FI v3 update is that of the four Flexi 
Controllers. These constitute what is sometimes referred to as a “modulation matrix” and 
provide a way to control almost any slider-based parameter in the editor in a very flexible 
and intuitive way from a choice of control sources.  3

What does this mean? Well, one example of a control source is an envelope and earlier 
we talked about the FI’s VCF envelope. If you remember, this controls a fixed destination, 
namely cutoff frequency of the filter. Now, using a Flexi Controller, you can take that VCF 
envelope and send it to almost any destination of your choosing, for example the pitch of 
an oscillator, the speed of the LFO, the grade of the distortion, even the decay stage of 
the VCF envelope itself! 

The power of Flexi Controllers opens up a truly mind-blowing number of possibilities for 
creating complex, highly-expressive and unique sounds, limited only by your imagination 
and your willingness to experiment. 

 

The process of setting up a Flexi Controller assignment is a relatively simple one and 
basically consists of choosing a source and a destination. There are then a few choices to 
be made which alter how and to what degree the source modulates the destination. This 
will all be explained below later. 

The four Flexi Controllers are situated towards the right in the top portion of the editor 
screen. Each has a different color to distinguish it from the others but all are identical in 
function. 

The panel of each Flexi Controller has four windows and a pushbutton and these are as 
follows: 

3 There are 13 sliders that can’t be controlled by Flexis: the 3 ON/OFF sliders in each of the effects, 
the INSTR and VCF sliders of the EQ and Overdrive, the TRANSPOSE VOICE2 and VOICE3 sliders 
of the harmonizer section, the VCF TYPE and PITCH FOLLOW sliders of the filter section, the ENV 
MODE slider of the envelopes block and the KBD PRIORITY slider of the MIDI block. 
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● SOURCE: 
Click here to open a pop-up menu with the list of control sources. Click on a 
source to select it. (The full list of Control Sources is given here in the appendix.) 

To close the menu without selecting a source, click on the X or anywhere in the 
panels above the menu screen. 

● MODE (QUANTIZE/CONTINUOUS): 
Click here to select whether the control source modulates the destination 
parameter either smoothly or in quantized steps. 

e.g. If the destination is PITCH COARSE then CONTINUOUS will adjust the pitch 
smoothly, whereas QUANTIZE will adjust it in semitone steps. 

● RANGE CTRL: 
Click here to open a pop-up menu with the list of Range Controls.  

A Range Control is used to give you real-time, direct live control over the depth of 
modulation from the source to the destination. 

e.g. If the Range Control is PITCH, then the modulation depth from the control 
source will change according to whether you play in the lower register or the 
higher register of your instrument. 

Above the list of Range Controls is a POLARITY button. Click here to select 
whether the range control is applied positively or negatively. 

Going back to the above example, if the polarity is positive (+) then modulation will 
increase as you play from low to high. By contrast, if the polarity is negative (-), 
the behavior is reversed. 

Click on a Range Control to select it. 

To close the menu without selecting a range controller, either select OFF, click the 
X or click anywhere in the panels above the menu screen. 

Range Control is explained in a bit more detail further below and a full list of the 
Range Controls is given here in the Appendix. 

● CURVE: 
Click on the curve graphic and drag it up and down to select one of the Flexi 
Controller’s sixteen available transformation curves. The curve types are linear, 
exponential, logarithmic, S-shaped and hard-transition, of varying slopes. The 
various curves alter how the modulation from the control source is applied to the 
destination. 

e.g. If the control source is PITCH and the destination is DRIVE then using a 
linear curve will cause the distortion to increase evenly as you play chromatically 
up through the range of your instrument. By contrast, using an exponential curve 
will cause the distortion to be applied only slightly at the lower range of your 
instrument but it will be increased more dramatically towards the upper range. 
 
A diagram of all sixteen transformation curves is given here in the Appendix. 

● LEARN/CLEAR: 
Click this pushbutton to assign a destination to the Flexi Controller. The button will 
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begin blinking to indicate it is waiting for a destination to be chosen. Click on a 
parameter’s slider to select it as a destination and the button will remain lit. (If no 
destination is chosen within 10 seconds, the blinking light will time out.) 

When clicked, the single slider will split into two, forming a pair of sliders whose 
color matches that of the Flexi Controller slot used. The position of the left slider 
determines the base (unmodulated) value of the parameter (i.e. it functions exactly 
as the normal, non-split slider did). The position of the right slider, which can be 
set above or below that of the left, determines the maximum deviation from the 
base value when the modulation from the control source is at its maximum 
amplitude; it also determines the direction of the modulation. 

e.g. If the Flexi Controller’s control source is an LFO and its destination is PITCH 
COARSE, then setting the left slider to 0 and the right slider to 12 will cause the 
pitch to be one octave higher than the base pitch when the LFO is at the peak of 
its cycle. 

Staying with this example, then setting the right slider above the left will cause the 
pitch to rise as the LFO rises. Conversely, setting the right slider below the left will 
cause the pitch to fall as the LFO rises. 

At the instant the two sliders first appear, they both have the exact same value. 
When adjusting the the left slider, both sliders move together, continuing to share 
the exact same value. By contrast, when adjusting the right slider, the left slider 
does not move. 

After setting the right and left sliders to different values, adjusting the left slider will 
again cause both sliders to move together, always maintaining the set distance 
between them. If, however, while adjusting the left slider, the right slider hits the 
upper or lower limit of its travel, then continuing to move the left slider in the same 
direction will cause the distance between the two sliders to become compressed. 
This compressed range will now be “remembered”; when moving the left slider 
back in the other direction again, this new, shorter distance between the two 
sliders will be maintained. To increase the distance again, adjust the right slider. 

By default, the value displayed above the paired sliders is that of the left slider. 
Clicking on the right slider will cause its value to be displayed instead for as long 
as the mouse button is kept pressed. Upon releasing the button, the display will 
revert to default after a short delay. 

To delete a destination assignment, click once more on the red button in the Flexi 
panel and the slider will return to its normal, non-split state. 

Note 1: It is not possible for a single destination to be assigned to more than one 
Flexi Controller. If you try to assign a second Flexi Controller to a slider that is 
already assigned, then the new assignment will overwrite the old one. 
 
Note 2: You can only assign an EQ parameter as a destination for a Flexi Controller 
from within the slider-based panel. As soon as an EQ parameter has been assigned 
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as a Flexi destination, the graphical EQ panel will be disabled for as long as the 
assignment remains in place. 

 

There is a COPY option in the lower left part of the 
screen to copy all parameters (except the destination) of 
one Flexi Controller to one or more of the other Flexi 
controllers. Click on the FLEXI button to show the FLEXI 

checkboxes (if they aren’t showing already). Select a source FLEXI from the left side and the 
destination FLEXI(s) from the right side, then press COPY. 

 

That may seem like a lot of information to take in, so let’s try to consolidate it by working 
through an example of setting up an assignment and playing around with the various 
settings to hear what they do. Let’s use a Flexi Controller to create a 4-semitone pitch sweep 
of an oscillator: 

First, set up a simple sawtooth sound on VCO1 and VCO2.  Set VCO1 PITCH COARSE to 4

12. Set the filter VCF TYPE slider to OFF. When you play a note, you should hear the two 
oscillators pitched an octave apart. 

Select the NOISE ENVELOPE as Flexi 1’s source via the SOURCE window. Set the 
ATTACK of the noise envelope to minimum and its DECAY to 110. 

Now assign Flexi 1 to VCO1 COARSE by first clicking on the LEARN button in the Flexi 1 
window and then clicking on the VCO1 COARSE slider. Set the left slider to 12 and the 
right slider to 16. 

Make sure mode is set to QUANTIZE by clicking in Flexi 1’s MODE window.  

Select a linear curve from the curve window by dragging the graphic. 

Now, play a C and you will hear that VCO2 plays a steady C, whereas VCO1 plays 
chromatically from E down to C. 

Change the MODE to CONTINUOUS. Now when you play, the pitch will drop down 
smoothly instead. 

Move the right slider from 16 down to 8. Now when you play, the pitch of VCO1 starts at 
C and moves up to E. 

Adjust the right slider to 24 to get a full octave sweep. Set MODE back to QUANTIZE and 
choose a few of the different curves. Notice how the timing of the pitch sweep changes as 
you play using the different curves. 

  

4 If you don’t know how to do this then first look at the section of the manual called Building your first 
sound. 
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More on Flexi Range Control 

In the above example, you may have noticed that, interesting as they were, the modulations 
we set up using the Flexi controller caused the sound to repeat the same way each time we 
played a note, using any given setting. This is because we used an envelope; an envelope, 
along with the LFOs and noise sources, belongs to a group of sources that we cannot 
control directly as we play. These are known as internal sources. In the FI, there is also a 
group of external sources and these sources are under our direct control as we play. The 
group consists of the Envelope Follower, Accent, Pitch, Aftertouch, Pitch Bend Wheel, or 
any assignable MIDI CC. 

Any external source can be used as a Range Control. A Range Control allows us to 
manually limit the amount of modulation applied from the control source to the destination. 
Turning back to our example, we could for instance use an expression pedal sending out 
MIDI CC1 to control, in real time, how much the noise envelope affects the pitch of VCO1. 

As you already know, a Range Control can act with either positive or negative polarity: 

With positive polarity (+) , then, when the range control is at 127, the control source will be 
completely uninhibited and will act with maximum amplitude upon the destination. By 
contrast, when Range Control is at 0, the modulation will be suppressed. 

With negative polarity (-), then, the reverse happens; when Range control is at 0, the control 
source will be uninhibited and will act with maximum amplitude upon the destination. By 
contrast, when Range Control is at 127, the modulation will be suppressed. 

 

Special Flexi-only Modulation Sources 

There are eight modulation sources in the list which can only be used with Flexi Controllers - 
they are not found elsewhere in the editor. Six are LFOs and two are noise sources. They 
are explained below. 
 
 

● VCO3/VCO4 LFO (TRI/SQR/SAW): 
These two LFOs are completely new to the FI. Each of the two LFOs has three 
waveforms - saw, square and triangle. To conserve precious space in the editor, 
some sharing of sliders has become necessary: the LFOs’ frequencies and pulse 
widths are adjusted by using the LFO FRQ and OFFSET sliders from the PULSE 
WIDTH sections of VCO3 and VCO4. 
 
In order to have many different applications using a broad range of frequencies, 
VCO3 LFO is four times faster than VCO4 LFO.  
 
VCO LFO 3 is free-running, whereas VCO4 LFO is synchronized to the trigger event: 
whenever you play a new note, the phase of VCO4 LFO will be reset. 
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Note: The PULSE WIDTH OFFSET behaves differently than might otherwise be 
expected when used to control the pulse width of the VCO3/VCO4 LFOs. Ordinarily, 
when PULSE WIDTH OFFSET is used to control the square waves of the VCOs, the 
waveform is symmetrical at 0 and is a narrow pulse at 127. By contrast, when PULSE 
WIDTH OFFSET is used to control the pulse width of the VCO3/VCO4 LFOs, it is 
symmetrical (50% duty cycle) at 64; settings of 0 and 127 equate to duty cycles of 
approximately 10% and 90% respectively. See the diagram below: 
 
Pulse Width Settings 

  
● Pink Noise and White Noise: 

The white noise generator generates random, non-consecutive values. The noise is 
sampled at the frequency of VCO3 LFO. So if you use it, for example, to control the 
pitch of a VCO using a Flexi Controller in quantized mode, then you get something 
resembling a random arpeggio played at the speed of the VCO3 LFO.  
 
The pink noise generator is lowpass filtered white noise. You can use it in a similar 
way to a triangle or sine-wave LFO, but the vibration is irregular and moves around 
completely randomly. The speed of the random movement can be adjusted with 
VCO4 LFO frequency. 

 
 

Some ideas for uses of Flexi Controllers 

Here are just a few examples of the ways in which Flexi Controllers could be used to create 
sounds on the FI that weren’t previously possible prior to version 3.00: 
 

● Set up two notch filters using the MID FREQ controls in the graphical EQ editor then 
assign LFO to sweep both mid frequencies to mimic a 4-stage phaser; 
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● Use the EQ to create two peaks similar to as described above but instead control 
with the VCF envelope (alongside the filter(s)) to create 3- and 4-peak filters;  

● Use an envelope to raise the volume of an oscillator to push it into foldover distortion; 
This can give sounds which sound similar to those made using “hard-sync”; 

● Make a sound’s character change completely depending on which register it is 
played in - perhaps guitar-only in the lower register, synth-only in the upper register; 

● Set different coarse tunings on the VCOs to create chords and then use a MIDI CC or 
ACCENT assigned to VCO PITCH COARSE to change chord quality on the fly; 

● Route an expression pedal (via a MIDI CC) to VCO TRANSPOSE with a setting of 24 
semitones to create a whammy pedal effect for the oscillators. 

● Create asymmetrical LFO behaviour by using an LFO as a control source and 
selecting a non-linear transformation curve to act on the destination. 
 

 

MIDI Controllers as Flexi Controller Sources and Range Controls 
If, when selecting a Flexi source or a Range Control, you choose a MIDI controller that 
has a default assignment in the FI, then that default assignment will be overridden. 

The default assignments and their respective default values are shown below: 

 

MIDI CC / Name Default Assignment in the FI Default Value 

1 Pitch/filter vibrato 0 /127 5

2 3rd (logarithmic) VCF volume of Main Mixer 127 

5 Portamento time 0 /127 6

7 Main output volume 127 

11 Filter cutoff 64 

65 Portamento ON/OFF 127 

66 FI ON/OFF --- 

67 Program decrement --- 

69 FI ON/OFF toggle --- 

74 Filter cutoff 64 

Pitch Bend Pitch bend --- 

Aftertouch Aftertouch --- 

Velocity Keyboard velocity control of filter cutoff in MIDI mode --- 

5 Synth Mode only. 
6 EWI Mode only. 
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The default values are recalled (all of them at once) when one of the following occurs: 

1. The FI is powered on; 
2. The editor changes one of the Flexi sources; 
3. A Program Change. 

 

Block Adjust Mode 

In the lower right corner of the editor there are 12 checkboxes. These correspond to the four 
VCO blocks, the VCF block, a combination of the ENVELOPES and LFO blocks, a 
combination of the DISTORTION and MAIN MIXER blocks, the EFFECTS block and the four 
FLEXI Controllers. Click on a checkbox to select a block. Any number of blocks can be 
selected and there are buttons to Select All or Clear All checkboxes. 

You can adjust the selected block(s) by clicking on one of the following two buttons: 

● Reset: Sets the parameters in the block(s) to their lowest values. 
● Random: Generates random values for all parameters in the block. 

Note: Though the MIDI block does not have its own checkbox, its parameters will be reset 
whenever a Reset is performed with all 12 checkboxes ticked. It does not respond to the 
Random button. 

  

Building your first sound 
Loading a pre-existing sound and playing around with the various parameters can be a very 
good way to learn how to manipulate sounds to your liking, but at some point you will 
probably want to start creating your own sounds. This next section will give you a few 
pointers on how to do just that. The examples assume you are creating a sound using the 
audio input for triggering. 
 
Connect the FI to your computer (a single cable is sufficient for this, unless you want to write 
your sound to the FI straightaway). Launch the Editor. 
 
Let’s start by zeroing out all the parameters so you can start from a clean slate. Using the 
block adjust tool in the bottom right of the Editor click Select All and Reset. 
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For synth sounds, we recommend only using a single oscillator at first until you have 
become familiar with the controls. Adding multiple oscillators adds complexity and you will 
need to be careful with the levels if you want to avoid foldover distortion and clipping. 
 
Note that due to the various gain stages in the signal path you may need to raise several 
sliders above minimum in order to hear anything. 
 
To hear your dry instrument signal, turn up the INSTR slider in the Main Mixer. You should 
hear sound straight away (providing the pedal is not bypassed). 
 
To hear a sound using the Synth you will first need to raise no less than 5 volume sliders! 
These are as follows: 

1. At least one VCO waveform amplitude slider - e.g. VCO1 AMPLITUDE SAW; 
2. That VCO’s master volume - VCO1 AMPLITUDE VOLUME; 
3. The synth volume going into the filter - VCF INPUT SYNTH; 
4. The VCF outputs of the main mixer - MAIN MIXER VCF LIN and... 
5. MAIN MIXER VCF LOG. 

 
If you are in one of the two ADSR envelope modes then you will also need to set the VCA 
envelope before a sound can be heard. To start with, set the S slider to 127 and leave all 
others at minimum. This gives a simple on/off gate signal when playing a note. (If you are in 
Vintage envelope mode then leave both the A and R sliders at minimum to achieve the same 
effect.) 
 
Lastly, the filter will need to be set with a sufficiently high cutoff to allow sound through. (You 
could set VCF TYPE to OFF to bypass it completely but for this example let’s use the filter.) 
Click the Vintage/New button to put the filter into New mode, set the Slope button to 24dB 
and raise the cutoff (VCF FRQ) slider to 122. You should now hear a sawtooth wave 
alongside the sound of your instrument. Lower the filter cutoff back down to 64 and you’ll 
hear the sawtooth sound become more muted. 
 
Now raise the A and D sliders of the VCF envelope to 64. This sets an envelope shape, 
though you still won’t hear any difference until you apply this envelope to the filter. To do 
this, raise the AD/ADSR slider in the Filter section; set it to 64 for now. You should now hear 
a synth brass-type sound. 
 
Experiment with the positions of the A and D sliders of the VCF envelope, the VCF FRQ 
slider, the AD/ADSR slider and the RESO slider to find a sound you like. If you want the filter 
to sustain at a cutoff level above that set by the VCF FRQ slider then raise the S slider of the 
VCF envelope. Also experiment with the position of the ENV FOLLOW slider to allow some 
control of the filter cutoff from your playing dynamics. 
 
If desired, you could remove your dry instrument signal from the sound entirely by using the 
INSTR slider in the Main Mixer, or you could mix it in to taste. When you are satisfied with 
your creation, click SAVE to archive it to your computer. 
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Note: We wanted to show you the above method so that you fully understand the processes 
and signal paths involved in setting up a synth sound from scratch. Now that you have, you 
may be happy to learn that there is a shortcut to setting up a basic starting sound - simply 
press the INIT button in the PROGRAM panel to get an initialized patch of a single sawtooth 
oscillator (along with some dry input instrument signal in the Main Mixer). 
 
Now let’s look at creating a sound using the Distortion block. Use the block adjust function 
to zero out all the blocks again. 
 
To hear a sound using the Distortion block you will need to raise the following sliders: 

1. At least one slider in the Harmonizer Mixer section - e.g. HARM MIX INSTR; 
2. The distortion block signal going into the filter - VCF INPUT DIST; 
3. The VCF outputs of the Main Mixer - MAIN MIXER VCF LIN and... 
4. MAIN MIXER VCF LOG. 

 
Again, if not bypassed, the filter will need to be set with a sufficiently high cutoff to allow 
sound through. Let’s bypass the filter this time so set the VCF TYPE slider to OFF. 
 
At this point you should hear sound but it might be very faint. This is because the sound is 
being made using your instrument as opposed to the synth; the synth has a much hotter 
output than the instrument signal. If you recall, unity gain of the instrument input is achieved 
when its sliders are at 127. Turn the VCF DIST and HARM MIX INSTR sliders to 127. Now 
also raise the DISTORTION TONE slider to 127 and you should notice a marked increase in 
volume. If it’s still not enough, try raising the VCF LIN and VCF LOG sliders. 
 
Now experiment with the positions of the DISTORTION GRADE and TONE sliders. You may 
need to back off some of the volume sliders at high GRADE settings. 
Now raise the HARM MIXER VOICE2 VAR slider until you hear distortion at a 5th above the 
original sound. Adjust the HARMONIZER TRANSPOSE VOICE2 slider to hear the different 
intervals. 
 
If desired, repeat the process with VOICE 3 and finally add in the VOICE1 slider. Experiment 
with different combinations, paying attention to the volumes, until you find a setting you like. 
You could also mix in some of your dry instrument signal using the INSTR slider in the Main 
Mixer. (If you wanted to, you could also switch the filter back on and adjust its settings and 
the VCF envelope settings as described above to further shape your sound.) When you are 
satisfied with the result, click SAVE to archive the sound to your computer. 
 
Hopefully you now have a better idea of how to go about creating your own sounds. 
Remember that you can create a sound using a mixture of the synth and the distortion 
blocks. If necessary, go back over the explanations given in the parameter block 
descriptions to reacquaint yourself with what the various VCO, LFO and effects sliders do 
and begin experimenting; again stick to using a single VCO until you are comfortable with 
the controls. Don’t be afraid to try things out - let your ears be your guide. We hope that your 
Future Impact v3 brings you many years of joyful music-making! 
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MIDI Implementation 
The FI will respond to the following standard MIDI messages: 

MIDI CC / 
Name 

Default Function in 
the FI 

Default 
Value 

Notes 

Note On  --- Active only in MIDI Mode. Also switches 
the FI into MIDI mode. 

Note Off  --- Active only in MIDI Mode. 

Aftertouch  ---  

Velocity Keyboard velocity 
control of filter cutoff 

--- Active only in MIDI Mode. 

Pitch 
Bend 

 --- Active only in MIDI Mode. 

Program 
Change 

 --- 1...99 for programs 1...99. 

1 LFO depth to VCF and 
VCO 

0*/127 *0 in SYNTH Mode only. See Remark 1 
below. 

2 VCF volume of Main 
Mixer 

127 See Remark 2 below. 

5 Portamento time 0*/127 *0 in EWI Mode only. See Remark 3 
below.  

7 Final output volume of 
FI 

127 See Remark 4 below. 

11 Filter cutoff 64 Duplication of CC74. See below.  

65 Portamento ON/OFF 127 If ≥64 then it switches ON; If <64, then it 
switches OFF. 

66 FI ON/OFF --- If ≥64  relay switches to ON. If <64, relay 
switches to OFF. (This message will also 
disengage the tuner, putting the FI into 
either the ON or OFF state, depending on 
the value of the message sent.) 

67 Program DOWN --- If ≥64 then program number first steps 
down by one, then it starts scrolling (as 
when holding the Program footswitch). If 
<64 then it stops again. 
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69 FI ON/OFF toggle --- If ≥64 then the FI flips between ON and 
OFF. If <64 then the message is ignored. 
(If the tuner is active then sending this 
message will disengage the tuner and put 
the FI into the OFF state.) 

74 Filter cutoff 64 Deviates ±1, ±2 or ±4 octaves from the 
cutoff value set by the VCF FRQ slider in 
the program. Range is set by VCF 
CONTROL RANGE in the boot menu. 

88 Program UP --- If ≥64 then program number first steps up 
by one, then it starts scrolling (like when 
holding the Program footswitch). If <64 
then it stops again. 

89 Tuner ON/OFF toggle --- If ≥64 then the tuner flips between ON and 
OFF. If <64 then the message is ignored. 
Whenever the tuner is disengaged, the FI 
reverts to the ON state (just as using the 
ON/OFF switch does). (CCs 66 and 69 will 
also disengage the tuner. See above.) 

90 Bank UP --- If ≥64 then bank number steps up by 1. If 
<64 then the message is ignored. 

91 Bank DOWN --- If ≥64 then bank number steps down by 1. 
If <64 then the message is ignored. 

 

Remark 1: Modulation (CC1) is routed to both VCF and VCO LFO Modulation. This means, 
that the depth set in the program will be reached if CC1 is at maximum (127). Practically, the 
modulation value(s) in the program will be multiplied with the MIDI controller value / 127.  

Beware: if you use the FI with a keyboard and set the Mod Wheel to minimum, CC1 will be at 
zero. If, at this point. you disconnect the MIDI keyboard and instead play the FI with your 
instrument via the audio input, you will find that there is no LFO modulation in the programs 
where you would expect it; this is because CC1 is still at zero. You will need to power the FI 
off and on again in order to reset CC1 to its default value of 127. 

Remark 2: Breath Controller (CC2) adjusts (logarithmically) the VCF volume of the Main 
Mixer output in the same way as the LFO modulations work; when the MIDI breath controller 
is at maximum (127) then this corresponds to the preset value in the program. This differs 
from Volume Control (CC7) in two aspects: 

1. It only adjusts the synth volume, it does not change the input instrument’s volume; 
2. It is located before the effects, so delay trails, etc. will not be muted when CC2 is 

lowered. 
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Remark 3: Portamento Time (CC5) operates in a similar fashion to CC1 and CC2; when 
CC5 is at maximum (127) then this corresponds to the portamento value set in the program 
via the PORTA TIME slider in the editor. 

Remark 4: MIDI Volume (CC7) is applied to the final output of the FI. It is independent of all 
program parameters. It is smoothed and acts logarithmically. Beware: if you use a keyboard 
or a MIDI pedal to adjust the volume of the FI and you disconnect it, the volume will only 
return to the default maximum value if you power the FI off and on again, change program or 
change one of the Flexi sources in the editor.  

 

MIDI THRU: The MIDI OUT of the FI will pass on all information from its MIDI IN, apart from 
CC6 (Data Edit), NRPN controllers and SysEx data. Please note that this feature can be 
turned on or off via the boot menu. 

 

Program Change Out: When a Program Change occurs on the FI either by pressing the 
Program footswitch or by receiving a Program Up/Down command coming through the MIDI 
IN, then the FI will send out the corresponding Program Change command via its MIDI OUT 
on the active MIDI Channel. By contrast, if the Program Change occurs by receiving a 
Program Change coming through the MIDI IN from an external piece of equipment, then the 
FI will not generate and send out a Program Change command. However, the 
externally-received Program Change command will appear on the MIDI OUT anyway if MIDI 
THRU is enabled in the boot menu. 

 
 

Specifications 
Technical specifications: 

● Size: 155 x 125 x 65 mm (6.1 x 4.9 x 2.6 inch) 
● Weight: 600g (1.32lb) 
● Power: 9V stabilized, 100mA, Roland-Boss-type, center-negative supply (not 

included) 
● True bypass (relay switching) 
● Super-high-performance DSP 
● All algorithms calculated with 32-bit accuracy 
● 24 bit AD/DA converters 
● Oscillators generated at 512 kHz oversampling 
● Distortion calculated at 128 kHz oversampling 
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Connectors: 

● Audio in jack 
● Audio out jack 
● 5 pin DIN MIDI in 
● 5 pin DIN MIDI out 
● 5.5/2.1 mm DC socket for 9V stabilized, center-negative supply 

  

Controls: 

● Input Level potentiometer 
● Output Level potentiometer 
● Parameter potentiometer 
● Edit dial for parameter editing 
● Bank Up pushbutton (on the Edit dial) 
● Program Footswitch 
● On/Off Footswitch 

  

Displays: 

● 3 VU meter LEDs, green: -18dB, yellow: -11dB, red: -5dB 
●  On/Off indicator LED 
● 3-digit, 7-segment display: Bank Number, Program Number, Edit Data 

  

Features: 

● Covers the full range of 24-fret 4, 5 and 6 string bass guitars; 
● 99 Programs; 9 Programs in Bank 0, 10 Programs in each of Banks 1…9; 
● First 9 programs Deep Impact compatible; 
● Sounds can be designed and archived with the PC Editor software; 
● Major sound parameters can be changed easily on the device itself; 
● Free sound libraries will be published; 
● Firmware update via MIDI; 
● Firmware updates are free. 

MIDI Expander Features: 

● Portamento: fixed-time or fixed-rate 
● MIDI channel, pitch bend range, octave transposition settings 
● Trigger / Gate mode 
● Key priority: Lower, Upper, First, Last 
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Signal Processing Building Blocks: 

● 4 VCOs each with saw, square and triangle waveforms; 
● Each VCO has a separate LFO for PWM; 
● Each VCO has a separate decay envelope for saw amplitude; 
● Each VCO can generate complex dynamically changing waveforms using foldover 

distortion; 
● Harmonizer with 3 voices, variable transposition; 
● High quality guitar distortion for the harmonizer voices; 
● EQ control and noise gate for the harmonizer voices; 
● AD/ADSR envelope for the VCF; AR/ADSR envelope for the VCA; 
● Smooth crossfade between harmonizer and synthesizer voices; 
● VCF with Lowpass, Highpass, Bandpass and Notch mode; 
● VCF has 12dB/oct and 24dB/oct mode; 
● LFO with delay acting on VCO or VCF. 

  

Effects: 

● Bass guitar sound or synthesizer sounds can be routed separately to the effects; 
● Chorus, Flanger, Slapback, Reverb (Chorus Effects), Overdrive and 4-band 

parametric Equalizer effects; 
● Chorus, EQ and Overdrive effects are available simultaneously; 
●  The sequence of Overdrive and EQ is selectable. 

  

Requirement for using the FI: 

● A 9V stabilized, 100mA, center-negative, Roland-Boss-type power supply. 

  

Additional requirement for sound editing: 

● A MIDI interface and two MIDI cables for use with a PC (Windows 7 and above) or 
MAC (OS X 10.6 (Snow Leopard) and above).  
(Minimum screen resolution - 1280x900.) 
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Appendix  
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Algorithm Block Diagrams
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The Editor Panel (Classic) 
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The Editor Panel (LCD) 
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Flexi Control Sources 

 

Flexi transformation curves 

 

Flexi Range Controls 
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Compatible MIDI interfaces 

Below is a list of the MIDI interfaces we have tested for use with the Future Impact v3 Editor. 
Unless otherwise stated, these work for patch editing/transfer and for firmware updates. 

Name Remarks 

Panda-Audio midiBeam All work perfectly. 

Roland UM-ONE MK2 

Steinberg UR22 

RME Fireface UC 

M-Audio Fasttrack-Pro 

M-Audio Midisport 4x4 

M-Audio Firewire 1814 

Behringer UMC404HD 

Presonus Firepod 

Bespeco BM USB100 

Focusrite Scarlett 8i6 

Focusrite Scarlett 18i6 

Audiobox USB 

RME UFX 

ESI M4U XL 

Focusrite Scarlett 2i4 Does not work for firmware updates or 
writing all 99 sounds at once. Works for 
everything else but with intermittent errors. 

Edirol UM-1S Works in 90% of cases, some errors 
experienced but useable. 

Alesis USB MIDI cable Does not work. 

Any unbranded USB MIDI cable Does not work. 

Akai EIE/EIE-PRO Does not work. 

Miditech Midilink-mini No SysEx implementation at all - unusable. 
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FI as a replacement for standard single-effect pedals 

As we mentioned all the way back in the introduction, the FI can perform the function of a 
number of single-effect pedals (sometimes more than one at a time). In this section we’ll 
explain how to set up the pedal to achieve that via a few examples. Feel free to experiment 
and alter the settings used in the examples once you’ve tried them out. 
 

FI as envelope filter 

First let’s look at how to program the FI as a standard envelope-controlled filter. For the 
purposes of this example, let’s assume you are using a bass. Use the block adjust function 
to zero out all parameters.  
 
For this effect, you will need to route your bass’s output through the filter. Remember that 
unity gain is at 127 for the audio inputs. You will need to raise the following volume sliders: 

1. The bass signal going into the filter - VCF INPUT INSTR; 
2. The VCF outputs of the main mixer - MAIN MIXER VCF LIN and... 
3. MAIN MIXER VCF LOG. 

 
If you want to mix in some of your dry bass signal then raise the MAIN MIXER INSTR slider. 
 
The filter will need to be set with a sufficiently high cutoff to allow sound through; start with 
52 (after setting the VCF mode to NEW). Set the Slope to 12dB. Select the lowpass filter and 
set the resonance to about 30. 
 
As you might guess from the name, an envelope-controlled filter makes use of the Envelope 
Follower to sweep the filter cutoff frequency. This might lead you to think that you simply 
need to turn up the ENV FOLLOW slider to get the desired result. However if you do, you’ll 
find the results aren’t particularly satisfactory. Much more pleasing results are obtained when 
you set an envelope shape using the AD or ADSR envelopes, allowing that to be the main 
driver of the filter cutoff and then add a subtle amount of Envelope Follower to give some 
dynamic control. 
 
As a starting point, set the Envelope Mode to RESTART and set the VCF ADSR sliders to 
50, 80, 50 and 1 respectively. Now, in the FILTER section, set the AD/ADSR slider to 45 and 
the ENV FOLLOW slider to 25. You should hear a much nicer result now. 
 
Experiment with the positions of the ADSR sliders of the VCF envelope, the balance of 
AD/ADSR and ENV FOLLOW amounts, the filter type and slope and the resonance. You’ll 
find there are many fantastic variations to be had. Also try adding some overdrive for a bit 
more bite post-filter or add some distortion pre-filter using the DIST slider of the VCF INPUT. 
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FI as chorus 

A chorus is achieved by taking the dry signal (instrument, synth or both) and then using a 
delay line to create a copy of that signal. The delay time of the copied signal is then 
modulated using an LFO which causes its pitch to fluctuate. When paired with the original 
signal in a 50/50 mix, the tuning differences create the characteristic shimmering sound. 
 
Start by using just the dry instrument signal turned up to 127 in the Main Mixer. Switch on 
the EQ section and raise its INSTR slider to 64 to give a 50/50 dry/wet mix. Chorus delay 
times are around 20-35ms. (The maximum delay time on the FI is about 160ms which 
means that each 1 on the delay sliders corresponds to about 1.26ms.) Set the DELAY1 
slider to 20 (approximately 25ms). Turn up the LEVEL1 slider to hear the delay; it is quite 
short so you may not perceive it very well. Now set a speed on LFO A - start at about 60. 
You won’t notice any change until you turn up the MOD1A slider - set this to about 10. This 
will start to vary the delay time. 
 
Experiment with the LFO A FRQ and the MOD1A amounts. To keep the results sounding 
musical, apply less modulation at fast LFO speeds; more modulation can be applied at low 
LFO speeds. You could also try adding a second delay line with different LFO and MOD 
settings to further thicken your sound. 
 

FI as flange 

Flange is fairly similar to chorus but uses shorter delay times of around 5-15ms and the mix 
is mostly wet. It also typically uses feedback. 
 
Again start by using just the dry instrument signal turned up to 127 in the Main Mixer. Set the 
Chorus INSTR slider to about 105, the LFO A FRQ to about 10, the LEVEL1 slider to 63, the 
DELAY1 slider to 5 and the MOD1A slider to about 30. Now set the FBCK LEVEL slider to 
about 100. 
 
Experiment with negative settings of the LEVEL1 slider and with the LFO and MOD settings. 
Again, try adding a second delay line. When the delay times are quite short or close 
together, it can be useful to use LEVEL1 with a positive amount and LEVEL2 with a negative 
amount (or vice versa). 
 

FI as phaser 

Using filtering, a phaser combines a dry signal with a phase-shifted version of itself. Any 
out-of-phase frequencies will then cancel each other out and create “notches” in the 
frequency spectrum. These notches are swept across the frequency spectrum using an LFO 
to give the characteristic swirling, swooshing sound. 
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This effect can be achieved on the FI by using the EQ section in conjunction with Flexi 
Controllers. Start by using just the dry instrument signal turned up to 127 in the Main Mixer. 
Switch on the EQ section and turn on its INSTR slider. Using the graphical EQ interface, 
space out the two yellow circles for the mid frequencies then drag both down to create two 
notches. Right-click and drag to change the width of the notches. Now switch to the slider 
EQ panel view and assign two Flexi controllers, one to each of the MID FRQ sliders, using a 
common LFO as their control source; set the same offset on both sets of split sliders so that 
the notches move in unison. (e.g. if MID FRQ1’s left and right sliders are set to 0 and 40 
respectively (an offset of 40) then, if MID FRQ2’s left slider is set to say 60, then its right 
slider must be set to 40 higher, so 100.) Experiment with the frequency and shape of the 
LFO and with the depth, width and spacing of the notches. 
 
To make the effect more dramatic, turn up the VCF INPUT INSTR slider, set VCF MODE to 
OFF to bypass the filter, turn up both VCF sliders of the Main Mixer and turn on the VCF 
slider in the EQ section. 
 

FI as tremolo 

A tremolo effect involves rapidly varying the volume of your sound cyclically. This is quite a 
straightforward effect to achieve: use a Flexi Controller with an LFO as its source and a 
volume slider as its destination. The volume slider could be a single VCO’s master volume 
slider or the volume slider(s) of the Main Mixer. By assigning different LFO shapes as the 
source you can create a variety of tremolo effects such as a smooth sine wave or a choppy 
square wave. 
 

FI as vibrato 

Vibrato is a simple cyclic pitch modulation of the input signal. It can be achieved in a similar 
way to the standard chorus we discussed above. 
 
As with the other effects, start by using just the dry instrument signal turned up to 127 in the 
Main Mixer. Apply a 100% wet chorus signal by turning up the INSTR slider in the chorus 
section to 127. Set LFO A FRQ to taste. Turn up LEVEL1 to 63. Either leave the DELAY1 
slider at 0 or raise it to a very low number such as 3. Now apply a low MOD1A amount of 
around 10 or lower. You can experiment with LFO speeds, MOD1A amount and the polarity 
of the LEVEL1 slider. 
 

FI as reverb 

The reverb capabilities of the FI are quite limited given the relatively short maximum delay 
time possible and the lack of any special algorithms. That being said, it is possible to create 
some settings which are usable. We’ll show some below, but feel free to experiment further. 
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Start by using just the dry instrument signal turned up to 127 in the Main Mixer. In the 
chorus, set the INSTR slider to around 22. Now, starting with LFO A FRQ and moving to the 
right, set the remaining parameter sliders to the following two combinations:  

● 4, 9, 63, 127, 25, 19, 63, 31, 27, 22, 54, 110 
● 0, 0, 63, 127, 25, 0, 63, 31, 0, 0, 27, 110 

 

FI as octaver 

Many analogue octave pedals produce a square wave one octave down from their input 
signal and this can be done on the FI too. Program a square wave oscillator with coarse 
tuning of -12. (Add another square wave two octaves down if desired.) Then use the lowpass 
filter with a static cutoff to remove the higher frequencies to taste. You can experiment with 
pulse width offset setting to further change the harmonic content of the sound. Try adding 
subtle envelope or envelope follower control to add bloom to the notes. Add EQ to beef up 
the bass if necessary. Mix in some dry sigal at the Main Mixer to taste. You could take this 
idea further and use a Flexi Controller to be able to bring the dry signal in and out via an 
expression pedal. You could also use the default CC11 or CC74 (or your own choice of CC) 
to adjust the filter on the fly. 
 

FI as pedal wah 

This is another quite straightforwardly achievable effect. As with the envelope-controlled 
filter, you will need to route the dry signal through the filter using the VCF INPUT INSTR 
slider and raise the VCF LIN and VCF LOG sliders in the Main Mixer. In theory you could 
use an expression pedal controlling CC11/CC74 to get a 2-, 4-, or 8-octave sweep of the 
filter (depending on the range set via VCF CONTROL RANGE in the boot menu). In practice, 
this isn’t defined enough; better results can be achieved by using a Flexi Controller with an 
expression pedal assigned to the filter cutoff (via any available MIDI CC) and specifying your 
own sweep range using the split sliders. Some famous wah-wah pedals use a bandpass 
filter instead of a lowpass filter so experiment to see which works best. You could try adding 
some resonance to add some variety. More dramatic results are possible when combined 
with overdrive and/or distortion. 
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Warranty and Return Policy 
You must never send back a device without consulting us by email first. A device should be 
returned to us only after consultation and if we have explicitly requested that it be returned. 
You must pay for the cost of shipping the device back to us. It is up to you which shipping 
service you use for the return, but it is your responsibility to ensure that we receive the 
device. The cost of repairing the device and sending it back to you will be covered by us 
during the warranty period of two years. After the warranty has expired, the cost of repairing 
and postage (both ways) must be paid by you. It is our responsibility to ensure that the 
device is received by you. 

 

FAQs 
 

● How do I access the tuner? 
Press and hold the ON/OFF switch to turn the tuner on; press the switch again to turn 
it off. 
 

● How do I choose which sound plays when the pedal is first powered on? 
The FI always starts up at the most recently-saved program. Navigate to the program 
you want to have as the start-up sound using the PROGRAM switch. Turn the EDIT 
dial one click in one direction, one click in the other direction then press the dial again 
to save.  
 
Note: if you subsequently edit another program’s parameters and save the changes, 
then that program will become the new startup program. 
 

● How do I change the order of sounds on my pedal? 
If you have never yet sent programs to your FI then the likelihood is that you are still 
using the default sounds on the FI. For the purposes of answering this question, let’s 
suppose this is the case. You’ll need to connect the FI to your computer using two 
MIDI cables as shown below. Launch the editor and go to the MIDI>Preferences 
menu. Connect the cables and choose the MIDI ports as follows: 
 

○ MIDI interface MIDI OUT (assigned to Output Device) → FI MIDI IN; 
○ FI MIDI OUT → MIDI interface MIDI IN (assigned to FI Input Device). 

 
Now go to the File menu and click Select Directory. Locate and select the folder 
called “v3_sounds”. If you don’t already have this folder on your computer then you 
need to go to http://pandamidi.com/support and download it. It is contained in the 
latest “Distribution Package”. 
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To change the order of the patches, you need to change the two-digit numerical 
prefixes at the beginning of the names of the files you wish to move. The prefix 
corresponds to the slot number on the pedal that the program will be sent to. When 
you have renamed the programs you wish to rearrange (taking care to avoid any 
duplication of prefix numbers) then click WRITE ALL to write the programs in the 
folder to their newly chosen locations on the pedal. 
 

● How do I listen to and add new sounds to my pedal? 
Firstly you’ll need to download the Program files of any sounds which you want to 
audition. It will be helpful to place these all in a single folder on your computer as it 
will make browsing quicker. Connect your FI to your computer with two MIDI cables 
as shown in the question above. (If you just wish to audition sounds without writing 
them to the FI then you only need to connect one cable from the MIDI OUT of your 
computer to the MIDI in of the FI.)  
 
Launch the editor and in the File menu click on Load Program and click the first 
program in the folder containing your candidate programs. You should now be able to 
hear it when you play. Click on the + button to move to the next sound in the folder. 
 
If you have found a sound you like and want to write it to the pedal, click on the 
WRITE ONE button in the top left of the editor screen. Locate the program file. If the 
file name begins with a two-digit numerical prefix then this is the location (slot) on the 
pedal to which it will be written. If you want to write it to a different slot, first rename 
the file, prefixing the name with the two-digit slot number of your choice. When you 
are ready to write the program to your pedal, either double click the file or click Open. 
 
If you want to write multiple programs to the pedal at once, make sure they are all in 
a single folder. Go to the File menu, click Select Directory and locate the folder. 
Make sure that all files in the folder that you want to write to the pedal have a unique 
two-digit prefix corresponding to the slots you want them to be sent to. Click the 
WRITE ALL button to send the programs to the FI. 
 

● Does the FI have MIDI clock? 
No, the FI does not currently send or respond to MIDI clock signals. 
 

● Can I use an expression pedal to sweep the filter? 
Yes, you can! The filter cutoff in the FI is controlled by MIDI CC 11 and CC74. The 
pedal sweeps either 1, 2 or 4 octaves either side of the program’s preset cutoff value 
(the value set by the VCF FRQ slider in the editor). The sweep range is set by VCF 
CONTROL RANGE in the boot menu. 
 
You will need a third-party piece of equipment to connect the expression pedal to the 
FI’s MIDI In port. 
 

● How do I use an expression pedal to control the LFO depth? 
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LFO modulation depth to the filter cutoff and the oscillators’ pitch is controlled by 
MIDI CC1. You can again use a third-party product to attach an expression pedal and 
send the relevant CC messages to the FI 
 
You can also plug in a MIDI keyboard to the FI’s MIDI IN port and use the keyboard’s 
mod wheel. 
 

● Can I listen to and create sounds on the editor without using the pedal? 
No, in order to hear FI program sounds via the editor you must have the pedal 
connected to your computer. The sound is produced by the pedal; the editor just tells 
the pedal what settings to use. (Whilst it is technically possible to create programs on 
the editor and save them to your PC without having the pedal attached, there would 
be little point as you would be unable to hear how they sound!)  
 

● How do I restore the factory patches to my pedal? 
You will need to use the editor for this and connect the FI to your computer with two 
MIDI cables. If you haven’t done so already, go to http://pandamidi.com/support and 
downloaded the latest “distribution package” to your computer. The factory patches 
are located in a folder called “v3_sounds”. Once these are on your computer, go to 
the File menu, click Select Directory and locate the folder. Click the WRITE ALL 
button in the top left corner of the editor window to write the factory default programs 
back to your pedal. 
 

● How do I update my pedal’s firmware? 
You can update the FI firmware directly in your web browser (Chrome only) by going 
to https://auraplug.com/panda/fiupdate/start.html and following the on-screen 
instructions. You will need to connect the FI to your computer with two MIDI cables. 
 
Alternatively you can download the latest firmware from http://pandamidi.com/support 
and install the update using the editor. Power on the FI while holding down both 
footswitches. Select Firmware update from the File menu in the editor and follow the 
instructions. Once the update has successfully installed, power the FI on and off 
again. See the Firmware Update section in the File menu for full details of the 
update process. 
 
Important: If you update your FI’s firmware to 3.00 from an older version then the 
tune base will not be at 440 and so the tuner will show “incorrect” pitch values. You 
must reset the tune base. You can do this by performing a RESET ALL. Alternatively, 
if you do not want to lose any program settings made with the PARAMETER and 
EDIT dials, you can manually set the tune base to 440 (or any other desired value). 
(See the section on the boot menu for how to do this.) 
 

● Can I play chords on the FI, is it polyphonic? 
These are really two separate questions. The FI cannot respond to polyphonic input, 
that is, you cannot play chords on your guitar and have the FI synthesize them. The 
FI responds only to monophonic input pitches. You can however play chords using 

Go to Table of Contents 
71 

http://pandamidi.com/support
https://auraplug.com/panda/fiupdate/start.html
http://pandamidi.com/support


the FI in the sense of being able to set the oscillators to different pitches to give a 
polyphonic output. With the clever use of Flexi Controllers routed to oscillator pitches, 
you can even change the chord quality on the fly. 
 
If you are using the FI purely as a substitute for a single-effect pedal such as chorus, 
distortion, flange, etc. (where the synthesizer section is not in use) then of course you 
can play with full chordal input.  

 
● Where have all the “bass” sliders gone? 

As already mentioned, though the FI was originally a pedal for bass guitar, it can now 
be used with a variety of instruments, thus we deemed it necessary to change the 
names of the “BASS” sliders to “INSTR” (instrument) to reflect this. Rest assured, 
they function in exactly the same way as they did before. 
 

● My tuner is out of tune - how can I fix it? 
If you have updated your FI’s firmware to 3.00 from an older version then the tune 
base will not be at 440 and so the tuner will show “incorrect” pitch values. You must 
reset the tune base. (See the section on the boot menu for how to do this.) 
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